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Welcome 
 

 
SummaFlex Pro is software that integrates the flatbed into the workflow. It is the perfect link 
between the design station, RIP station, printers and cutting devices. 
Once the workflow is set up, macros automate the process. Consequently, the operator's 
handling before starting the next job is reduced to a minimum as well as the downtime of the 
table. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This manual is a reference guide for the use of SummaFlex Pro 
Minimum revision needed for this manual: 7.5.18 
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1 Operation 
 
 
 
1.1 Introduction 
 
SummaFlex Pro is a front-end application software with job preparation, post processor and 
import plug-ins for CAD and illustration software (e.g., Adobe Illustrator and CorelDRAW). 
Once the workflow is set, macros automate the process. Consequently, the operator’s 
handling before starting the next job is reduced to a minimum. The downtime of the table is 
also reduced to a minimum. 
 
1.2 SummaFlex Pro sidebar 
 
SummaFlex Pro has a side bar that groups the most used actions for a normal workflow. The 
standard sidebar has 5 tabs. 
 

 
1.2.1 Layer tab 
 

 
Click this tab to assign the tools to certain layers. The procedure to set up the layers is 
explained in section 2.3. 
 
1.2.2 Files tab 
 
The files tab is a file manager. A preview shows the file content, using a thumbnail. The list 
view offers overview for large file sets. Any directory with subdirectories can be searched 
automatically.  Individual search paths can be defined for direct access. A search box makes 
it easier searching by file name. 
There are two predefined directories. These directories can be changed or directories can be 
added.  
The first directory list has a fixed file filter (just typical SummaFlex Pro files).  If the directory 
contains subdirectories, it is selectable to show them or not.  The subdirectory can then be 
chosen by clicking on the dropdown box next to it. 
The second directory list has a selectable file filter (in the figure below it is set to pdf files) if 
the directory contains subdirectories, it is selectable to show them or not.  The subdirectory 
can then be chosen by clicking on the dropdown box next to it. 

 

NOTE: <Ctrl> 2 is used to hide or show the side bar. The blue arrow at the top of the 
side bar is used to minimize or maximize the side bar. It is recommended to always 
use the side bar, if possible. 

 

NOTE: The layers are setup automatically after the correct device is installed. In 
order to set up layers: Install the device, close SummaFlex Pro, then open 
SummaFlex Pro again. A red V is visible in front of each layer name, if the layer has 
been set up for that tool. The layers are all set up in the below figure. 
If the layers are not set up, then the tools can be individually assigned to the layer. 
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FIG 2-1 

2-1 SUMMAFLEX PRO FILE MANAGER 
 

 can be used to add a directory.  can be used to edit a directory name and change 

options for that directory.   is used to refresh the preview view. This folder can be set to 
be monitored continuously or not (check the option ‘monitor folder’ when setting a folder). 
 
These directories can also be set as a hot folder or not. If set as a hot folder, the directory is 
monitored automatically and there are some extra options available.  
 

 
FIG 2-2 

2-2 SUMMAFLEX PRO HOT FOLDER SETTINGS 
 
The option exists to jump to the macro tab when the file is opened (recommended setting).  
You have the choice to delete the file after usage, to move it to another folder, or to leave it 
alone. Also the barcode type can be set here. 
If ‘macro assignment’ is used, then the action can be set after a file is chosen and double 
clicked or it can be used if a new file appears in the hot folder directory. 
Another possibility is to open a file immediately after the RIP creates it.
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1.2.3 Object tab 
 
The object tab shows the object manager. The task of the Object Manager is to provide 
access to any object that is on the desktop with the help of a clear tree structure. This is 
important when the access is challenging because of the complexity of the design or 
overlapping objects and graphics. In addition to single objects, the structure of groups and 
combinations is also depicted. 
 

 
FIG 2-3 

2-3 SUMMAFLEX PRO OBJECT MANAGER 
 
1.2.4 Clipart tab 
 
If SummaFlex Pro is used for designing, then a clipart library can be built. The Clipart 
Manager permits fast access to frequently required graphic vector objects such as logos, 
clipart’s, pictograms …The organization takes place via individual groups. Access to 
contents of the respective group is done by double clicks or "Drag & Drop". Some cliparts are 
installed during the installation of the program. 
 

 
FIG 2-4 

2-4 SUMMAFLEX PRO CLIPART LIBRARY 
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1.2.5 Macro tab 
 
The macro tab shows all predefined macro’s, which are installed. If a job is loaded, this tab 
also shows the used layers in the loaded job together with the assigned tools. To start a 
macro, either double click on the text or click on the blue arrow. 
Some settings exist to change the look of the macro tab. To change the view, click the 
dropdown box at the top and click on global settings. 
 

 
FIG 2-5 

2-5 CHANGE THE VIEW MACRO TAB 
 

The first option is to show the tooltip or not when the mouse is situated above a macro. 
The second option is the size of the icons that can be set larger or smaller (size of the text 
stays).The third option is the number of quick layers (see later). 
 
1.2.5.1 Pre-installed macro’s 
 

  
 
These are the macros for file handling. The first two macros are used for importing files, 
made by design software. There are a couple of options when importing a file.  After choosing 
the file type, a preview can be shown, the insertion point can be set to the origin, a default 
rotation (steps of 90 degrees) can be set and a scaling factor can be chosen.  All the settings 
used during importation will be automatically set by default during the next file importation. 
When Barcode (with hand scanner) is used to open a file, a window is opened first where the 
type of barcode can be chosen. Then the path where the cut files are located needs to be set 
correctly. The name of the file can either by filled in with the keyboard or can be read from 
the printout with an external barcode reader. The possibility exists here, as well, to set a 
default rotation (in steps of 90 degrees). 
The file ‘open macro’ is used for opening jobs in SummaFlex Pro format (cutting job with 
settings and other job info, this extra job info can be checked by going to ‘job info’ under the 
edit menu). 
 

 
 
The files that are imported sometimes contain objects that are not closed or contain objects 
on top of one another, resulting in cutting certain objects twice. This macro can be used to 
clean such files. To clean up automatically, click the macro to start and click the OK button. 
To clean up manually, refer to section 2.8.7. 
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This can be used to rotate the job, so it fits the table orientation. The orientation on the 
screen should be the same as the orientation when the user stands in front of the machine. 
 

 

 
 
SummaFlex Pro has a sorting algorithm to sort the order in which the objects are cut out. It 
does not sort individual vectors, it sorts the objects (closed curves). This macro can be used 
to visualize how the program sorts. Sorting can be set on or off in the output window. 
 

 
 
This macro can be used when the design is printed on the back of the material. This can be 
used in combination with the plug-in ‘Regmarks + Squares’. First the registration marks are 
cut out (squares), then the material is turned over, the square marks are read and then the 
job is cut (see section 2.8.5 for more information and detailed explanation). 
For installing the macro in SummaFlex Pro, copy the file “IA_Summa Cut from Backside 
Y.pr7” from “C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to 
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”. 
 

 
 
Use this macro to open the output window. 
 

 
 
If a file is opened, and the user does not click another tab of the sidebar, the layers used in 
the job are shown. The number of layers shown can be set in the global settings (see above). 
Use the scroll bar to view the other layers if there are more layers then are set to be visible. 
If the layers have been properly defined in both the design software and SummaFlex Pro, the 
correct tool is already assigned to cut out the job.  
If the correct tool has not been assigned, there is a greyed out picture of a tool. A tool can 
then be assigned by first selecting the layer and then clicking Default.  

The parameters of the selected tool can be changed by clicking the gears icon (  ) or by 
choosing a material if those were set up for that tool (see section).  

 is used to make the layer visible/invisible.   is used to lock/unlock the layer (objects 

are visible but not selectable).  can be used to select all objects on that layer. 
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1.2.5.2 Optional macro’s 
 
There are some extra macros copied on the hard disk of the computer but not installed in 
SummaFlex Pro.  
The folder C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros holds all 
the available macros. The macros, installed in SummaFlex Pro, are in the folder C:\Program 
Files (x86)\Summa\SummaFlex Pro\Macros. So the optional macros just have to be copied 
from the default folder to the folder below to be visible in the SummaFlex Pro sidebar. 
 

 

 
 

The File save macro is used for saving jobs in SummaFlex Pro format (cutting job with 
settings and other job info, this extra job info can be checked by going to ‘job info’ under the 
edit menu). 
For installing the macro in SummaFlex Pro, copy the file “D_file_save.pr7” from 
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to 
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”. 
 

 
 
Node editing is an advanced feature that can be used to enhance the cutting quality on 
curves with small radiuses. 
For installing the macro in SummaFlex Pro, copy the file “F_edit_nodes.pr7” from 
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to 
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”. 
 

 
 
This macro can be used to change the properties of the currently selected object(s) in the 
job. Sometimes this is more useful in print and cut jobs. 
For installing the macro in SummaFlex Pro, copy the file “I_object_properties.pr7” from 
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to 
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”. 
 

 
 
This is used for easy weeding when the Kiss Cutting Tool or the Drag Knife Tool is used in 
vinyl. After running this macro, the inner parts of objects will be cut with a cutout tool 
instead of the Kiss Cutting Tool or the Drag Knife Tool. 
For installing the macro in SummaFlex Pro, copy the file “HA Separate internal parts.pr7” 
from “C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to 
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”. 
 
 

 
ATTENTION: Make sure no files are deleted in the  ..\DefaultsMacros directory. 
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This macro is used for placing squares on top of registration marks. This macro can be used 
in combination with the “cutting from the backside macro” if the plug-in for Illustrator or 
Corel could not be used (this is the case when the RIP places the registering marks). First 
select all the marks in the regmark layer.  Then click the macro. The size of the marks can be 
set before the squares are created. The squares will be created in the layer Cut Out Squares. 
After this use the macro cutting from the backside. 
For installing the macro in SummaFlex Pro, copy the file “IB_Place squares.pr7” from 
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to 
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”. 
 

 
 
This macro is used for placing circles on top of registration marks. This macro can be used in 
combination with the “routing from the backside macro” if the plug-in for Illustrator or Corel 
could not be used (this is the case when the RIP places the registering marks). First select all 
the marks in the regmark layer.  Then click the macro. The size of the marks can be set 
before the squares are created. The squares will be created in the layer Cut Out Squares. 
After this use the macro routing from the backside. 
For installing the macro in SummaFlex Pro, copy the file “IB_Place holes.pr7” from 
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to 
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”. 
 

 
 
This macro can be used when the design is printed on the back of the material. First the 
registration marks are milled (circles) then the material is turned over, the milled marks are 
read and then the job is milled (see section 2.8.5 for more information and detailed 
explanation). 
For installing the macro in SummaFlex Pro, copy the file “IB_Summa routing from Backside 
Y.pr7   
from “C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to 
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”. 
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If it is not necessary to change anything in the output window, this macro can be used to 
start the job immediately without the output window popping up first. 
For installing the macro in SummaFlex Pro, copy the file “L_output to device_direct.pr7” from 
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to 
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”. 
 

 
 
This macro can be used to create rectangles around selected objects (that can be used as 
frame contour or trim boxes). The offset between the selected objects and the rectangle can 
be set in the macro. 
For installing the macro in SummaFlex Pro, copy the file “HB_Generate Cut Frame.pr7” from 
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\DefaultMacros” to 
“C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”. 
 

 
 
If it is not necessary to change anything in the output window and if the rip has been set up 
to use the correct tool with the correct settings, this macro can be used to start the job 
immediately without the output window popping up first directly after reading the barcode 
with the hand scanner. 
For installing the macro in SummaFlex Pro, copy the file 
“B_file_import_barcode_direct_out.pr7” from “C:\Program Files (x86)\Summa\SummaFlex 
Pro\Macros\DefaultMacros” to “C:\Program Files (x86)\Summa\SummaFlex Pro\Macros\”. 
 
1.2.6 Production tab 
 
This tab is only visible if the option barcode workflow is installed (see section 2.13. A special 
license file has to be bought and activated first to be able to use this option. 
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1.3 Setting up layers and tools in SummaFlex Pro 
 
It is recommended to go over the layer settings and the tool parameters before starting to 
work with SummaFlex Pro. If there are no layers used to send files to SummaFlex Pro, also 
colours can be assigned to certain tools.  These colours can then be used when creating 
templates in the design software.  If colours/layers are already predefined in the design 
software or RIP, this data can be used to set up the layers in SummaFlex Pro. 
It is recommended to use the default layer names / layer colours used in SummaFlex Pro for 
assigning tools to cutting lines and not vice versa. This is explained in the installation 
manual. 
 
Right click in the layer toolbar (if the toolbar is not visible, then click the layer tab at the 
right). A window opens in which layer names, layer colours and tool properties can be 
checked / set up.  
 

 
FIG 2-6 

2-6 LAYER MENU 
 
Use the layer names, shown for setting up a template in the design software, if the templates 
delivered with SummaFlex Pro can’t be used. 
 
The ‘Regmark’ layer has no settings. It is a special layer used for registration marks. 
 

 

 

 

ATTENTION: All registration marks should be in the regmark layer. If they are not, 
then recognizing them as registration mark is more complicated for SummaFlex Pro. 

 

ATTENTION: All registration marks must be defined as circles. The recommended 
registration mark size is 5 mm. The size of the registration mark should be the same 
as the size of the circle that is used to set the camera offset for maximum camera 
accuracy. 
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1.3.1 Tool (output) parameters 
 
The tool parameters can be set for each tool in each layer. This section describes the tool 
parameters. Not all tools contain all tool parameters; some parameters are redundant for 
certain tools. 
 

1. Slot position: is the position of the module where the cutout tool is mounted in. If 
only one cutout knife is used in the job, leave this on ‘auto’.  

2. HF routing speed: This is the speed at which the routing bit turns when the HF router 
is mounted onto the machine. 

3. Speed: This is the speed at which the knife cuts. Reduce this speed for thicker 
materials. 

4. Down position offset: The cutting depth can be adjusted with this parameter. This 
parameter can only have positive values. The maximum cutting depth of a tool is 
calibrated with Axis Control. This parameter can be used if the tool has to cut less 
deep than the calibrated depth. 

5. Material thickness: Is the total media thickness. If this parameter is shown, the next 
three parameters are also shown. These four parameters always appear together. 

6. Cutting (milling) depth: Is the depth that has to be cut (milled). It has the same value 
as the one of media thickness if the media needs to be cut (milled) completely 
through.  If this value is not the same as the media thickness, the media will not be 
cut (milled) completely through. 

7. Max depth per pass: Either the material is too thick to be cut (milled) in one pass or 
the tool cannot cut (mill) the media in one pass. This parameter sets the maximum 
depth per pass. 

8. Depth of last pass: This is the cutting (milling) depth of the last pass. SummaFlex Pro 
calculates the amount of passes it needs, depending on the values of the cutting 
(milling) depth, maximum depth per pass and depth of the last pass. If the last pass 
is used as ‘cleaning pass’ this parameter has a lower value then the maximum depth 
per pass. 

9. Lift up angle: This is the maximum angle the cutter will cut without need to lift the 
knife. If the angle between two consecutive vectors is larger than the set value, the 
cutter will lift the knife, turn it, put it down again and then cut further. If this value is 
raised, then the speed at which the job is cut might be higher, but the quality will be 
lower. 

10. Overcut Compensation Mode: Cutout knives are often used to cut thick materials. This 
means that a relatively large natural overcut is formed at the top of the material. If 
the cutout knife is a single edge one, this can be compensated by cutting the vector 
in two and making sure the machine cuts away from the start and stop point of each 
vector. There are 4 settings for this parameter: 

 

a. Off: switches off overcut compensation mode. 
b. All corners: this means overcut is compensated in each corner where the knife 

is lifted (where the corner is larger than the lift-up angle) 
c. inside: This means that the compensation will only be done for inner corners 

of closed paths.  
d. outside: This means that the compensation will only be done for outer corners 

of closed paths. 
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11. Overcut compensation distance: This is the distance between the place where the 
overcut compensation mode is done and the end of the original vector. This value 
depends on the thickness of the media. Use half of the thickness of the media as value. 

12. Break point overlap: Overcut compensation cuts each vector in two parts. This 
parameter determines how much these parts overlap. 

13. Overcut: Is used for easier weeding. Each time the knife goes up or down, the cutter 
cuts a bit further. The distance it cuts further is determined by this parameter. This 
overcut is the overcut of the center of the knife point and has nothing to do with the 
overcut described above. The resolution is: 1 = 0.1 mm for the drag knife and kiss 
cutting knife. The resolution is: 1 = 1 mm for other tools.  

14. Dynamic tool diameter compensation: This is used for the router option. A routing bit 
has, in contrast to a knife, a specific thickness. This means that the path, the routing 
bit needs to follow, must have an offset to the object, so the result has the exact size. 
This parameter sets the offset of the routing path on or off. The size of the offset is ½ 
the diameter of the routing bit (see next parameter).   

15. Tool diameter: Is used for the router option.  If the routing path has not been defined 
in the design, the bit diameter must be set here, so the program can calculate the 
routing path. For more info on routing see section 2.9. 

 
16. Tool diameter compensation: Is used for the miller option.  This parameter needs to be 

set at ‘Outside’ if an object needs to be milled.   When a hole needs to be milled, it is 
set at ‘Inside’. 

17. Tool diameter compensation for open objects: Is used for the router option.  When a 
curve is open, it is impossible to determine what is ‘inside’ and what is ‘outside’ the 
curve. So, usually this parameter is set to off. If this parameter is set to on, the router 
path is set under or above the open curve, dependent on the direction of the curve 
segments. 

18. Milling Orientation: This sets the orientation of the routing path. 
19. Lead-in/out: If this option is activated, the tool will use a circular arc move towards 

the curve that needs to be milled, unless there is a line in the curve. 
20. Speed of the last pass: This parameter controls the speed of the last pass (can be 

used as cleaning path). The set speed is usually lower than the speed of the previous 
passes. 

21. Cleaning path: This sets the cleaning path on or off.  It is used to get a better finish for 
routing and is also used when routing relatively small objects. The cleaning path is the 
same as the last pass. 

22. Cleaning path offset in %: This sets the size of the offset of the other paths to the 
cleaning path. 

23. Pause after tool: If this option is activated, the machine pauses after the use of this 
tool. 

24. Segment helper: This is an option to compensate small errors when cutting in panels. 
It needs to be set on or off in the layer settings. 
 

 

ATTENTION: The tool diameter needs to be set to 0 if the routing path was already 
defined in the design. 
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Click to change the parameter value in the value column. Clicking toggles the value, creates a 
dropdown box with a list or just makes the value changeable, depending on the type of 
parameter. 
 

 

NOTE: It is advised to build up a library of settings for frequently used materials. 
Save the different materials under “material”. (see section Error! Reference 
source not found.)  When this material is then re-used later, the parameters for 
that material can quickly be set by clicking the dropdown box under “material” 
and choosing the corresponded material. 

 
 

 
FIG 2-7 

2-7 TOOL PARAMETERS 
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1.3.2 Saving the layer setup 
 
Once the tools have been changed/defined, the layer setup can be saved by clicking the layer 
button (triangle left of the ‘Sel’ button) and then Save palette. It is recommended to delete 
the regmark layer. This layer is only used when working with the camera.   This is not 
supported in SummaFlex, only in SummaFlex Pro. 
 
Once the layer setup is done, the layer tab looks like the figure below. 
 

 
FIG 2-8 

2-8 LAYERS SET-UP 
 
A red V before a layer name means the tool for this layer has been defined. 
A blue V before a layer name means the tool is a router and the routing bit diameter has been 
set. 
The double black rectangles mean objects are defined in that layer.  
The order of the layers determines the order in which the flatbed cuts (or draws and cuts). 
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1.3.3 Adding a new layer 
 
SummaFlex Pro comes with a preconfigured number of layers.  If extra layers need to be 
added, e.g. for extra tools or to easily differentiate the same tool with different knives, add 
them as described in the procedure below. 
The procedure is written for setting up a special layer for not cutting completely through with 
a cutout knife. 
 
Click New. The layer setup window opens. First click Colour and choose the colour for the 
layer. If the colour is chosen, then click on the Output button.  
 

       
FIG 2-9 

2-9 SETTING UP THE COLOUR FROM THE NEW LAYER 
 

Then click on Layer insert. The new layer will be inserted just above the currently selected 
layer. If the order needs to be different, then the order can always be changed afterwards.  
 

 
FIG 2-10 

2-10 INSERT LAYER 
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Fill out the box underneath ‘Information’, choose the correct tool and adjust the parameters, 
if necessary. 
 
Do not forget to save the new layer. 
 

 
FIG 2-11 

2-11 SAVE NEW LAYER 
 

Click Save to save the newly inserted layer. 
Click Insert to insert a layer (must be in ‘colour mode’ for this). 
Click Delete to delete the selected layer. 
Click Save palette to save all changes that have been done while the window was open. 
 
If extra layers need to be added, first change the layer colour again. Otherwise the program 
will display an error message.  
 
It is recommended to define a new layer in the design software with the same name. If this is 
not done, the tool will have to be assigned when importing the design into the layer or the 
objects will have to be moved to the correct layer (see section 2.8.1). 
 

 
 

 

NOTE:  This procedure can also be used if, for instance, two types of cutout knives 
are used in one job (e.g. heavy duty and double sided) or two types of creasing 
wheels (e.g. crusher and creasing wheel). Then it is advised to use the name of the 
tool as layer name.  The slot position will then need to be set correctly, as well. 
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1.3.4 Setting up parameters for different materials 
 
Different materials need different settings. All those settings can be pre-configured. This can 
be done when setting up a layer. When a layer is set up (see paragraphs above) the moment 
the tool is chosen, a new dropdown box appears under the title ‘Material’.  
To set up a tool for a special kind of material, use following procedure: 

• Go to layer setup (right click in the layer toolbar - if the layer toolbar is not visible, 
click on the layer tab at the right). 

• Change the parameters according to the material that needs to be cut. 
• Click on the … box next to the dropdown box under ‘Material’ and select ‘Add…’. 
• Fill in the new name and click OK 

 
FIG 2-12 

2-12 ADD NEW MATERIAL 
 
To change the default values for the layer: 

• Make sure ‘Material’ is set to default, then change the tool parameters. 
• Click on the … box next to the dropdown box under ‘Material’ and select ‘Save 

profile’. 

 
FIG 2-13 

2-13 CHANGE LAYER DEFAULTS 
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Different defaults: 
 
If the … box next to the dropdown box under ‘Material’ is clicked, you have the choice 
between three sets of default values (see fig 3.9): 
 
Mode /Tool Defaults: These are the default values of the parameters as they were with the 
installation of the driver.  These defaults cannot be changed by the user. 

Material Defaults: If the parameters are set for a new type of material and those settings are 
saved in a profile (see above – setting up parameters for a new material) then those saved 
values are the default values for that type of material. 

Layer defaults: If a new layer is added or a palette changed and then saved (see section  
2.3.3 adding new layer), those saved values are the default values for that layer. 

 
To change the parameters in the job, just click the dropdown box underneath the tool name. 
 

 
FIG 2-14 

2-14 CHANGE TO PRE-DEFINED PARAMETERS 
 
If extra parameters need to be changed, click on the gears to the right of the tool name. 
However, it is recommended to predefine materials. 
 

 

 

NOTE:  It is advised to use easily recognizable names for setting up different 
materials. There are two types of names that are usually chosen. The first type 
consists out of using the name of the material that needs to be cut (e.g. B-flute 
Cardboard). The second type of name is a name in which the changed parameters 
are used (e.g. 50mm/s 10 lift up angle). 

 

NOTE:  These tool settings are saved in the driver file and are not palette dependent. 
If a new driver file needs to be installed, use the special installation program, 
otherwise the tool settings are lost (see installation manual). 
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1.3.5 Determine the order of tools that are used 
 
The order of the layers, with tools assigned to them, determines the order in which the table 
uses the tools. The order defined in the standard palette is logical, but should it be changed 
or should the order of new layers need to be changed, follow the next procedure. 
Click the fly out box in the layer menu just before the Sel and New buttons. Choose Layer 
Order and change the order of the layers. The tools, which cut completely through, should 
always be used as last. 

          
FIG 2-15 

2-15 CHANGING LAYER ORDER 
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1.4 Open or import a file 
 
1.4.1 General 
 
SummaFlex Pro has its own file format for saving files/jobs. These files not only contain the 
data from the design software but also the settings, used for executing the job (whether it 
has been executed or not) and other info.  To open a previous job, go to File menu and then 
click Open. However, the import function will be used mostly. 
 

 
1.4.2 Import filter setting 
 
The settings of the import filter can be set by going to Settings -> Standard settings -> 
Import/Export. 

 

 
FIG 2-16 

2-16 IMPORT SETTINGS 
 

 
 
This setup allows to define the search paths for the import as well as to select the file name 
for the automatic import of files (F12) and to select if the file has to be deleted after the 
import.  
If SummaFlex Pro is loaded and an EPS-file is saved in one of the given search paths under 
the defined name (for example SummaFlex Pro), it automatically activates SummaFlex Pro.  
This file will be loaded directly to the working surface. 
 

 

ATTENTION: It is recommended to work primarily in OXF and PDF file formats when 
exporting/saving from the design program. 
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When the imported or opened file contains bitmap data, it can take a long time before the 
preview is shown. Changing the value of these settings prevents SummaFlex Pro from 
creating a preview in the import window. However, it is recommended not to include bitmap 
data in the file that is prepared for importing into SummaFlex Pro. 
 

 
 
Above After Import settings are set at their recommended value. 
Fit working area to objects: When this box is checked, the working area is set at the bounding 
box of the objects plus a certain margin (here set at 2 mm all around). SummaFlex Pro uses 
the size of the working area for its calculations when preparing the output.  
Fix object size: When this box is checked, the size of the objects can’t be unintentionally 
changed by the user. If an object has a fixed size, then its selection handles are red (instead 
of black). 
Fix object size for output: When this box is checked, SummaFlex Pro does not change the size 
of the objects when it is cut out. The place and the rotation will be compensated, but not the 
size itself. This is again made visible with red selection handles. 
Separate layers by name: This option should be checked to facilitate the workflow. This 
makes sure that the registration marks are immediately recognized by SummaFlex Pro and it 
also makes sure that the correct tool is assigned to each object (if it was defined earlier). 
Search/replace jog marks: If this box is checked, SummaFlex Pro recognizes every circle as a 
registration mark. So keep it unchecked if the recommended settings for file import/export 
are used (layer with correct names). 
 

 
 
Above After Import settings are for DXF and HPGL import only. 
There is the option to close objects automatically. This option can be set on or off. The 
minimum gap can be set and also the layers, where the objects have to be closed, can be set. 
Another option exists to combine all objects per layer or not. 
All these pre-set properties can be changed later, if necessary. 
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The Import pdf setting is the option to suppress the select page dialogue box while importing 
pdf files. The other option is to embed job info when exporting to a pdf file.  
 

Extra settings can be set if the OptiSCOUT button is clicked. 
 

 
 

Create new job: If this box is checked then the import command works as if it would be an 
open command. 
And close active job: If this box is checked, then the active job is closed when a new job is 
imported. 
 
After Drag’n Drop....: It is not recommended to use drag and drop because the layer 
information is lost and usually the design computer is not the computer that is used to drive 
the flatbed.  
 

 
Load palette: If a different palette is needed temporarily, then this option can be used. Fill out 
the alternative palette and check the box in front of “load palette”. If the normal palette is 
needed again, then just uncheck the box. 
Loading palette is usually also not used. The palette is already correctly set in the design 
software or in the OXF-file from the RIP.  
 
Get jog marks from layer: This is the recommended way to detect the registration marks. 
There are a couple of layer names set by default. Other names can be added to make 
SummaFlex Pro compatible with other software. 
 
 

The Combine and group option affects the sorting algorithm of SummaFlex Pro, they are best 
left as they are. 
 

 

ATTENTION: Be careful with the option close active job. If this is used in 
combination with “do not ask for save on exit” option, then the previous job is 
closed without any warning and the changes made are lost. (see below) 
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Suggest filename as jobname: This option gives the possibility to let the program suggest the 
filename of the imported file when the job will be saved as a job file (native file format of 
SummaFlex Pro). 
 
The preferences that can be set when closing a file (job) can be found by going to Settings -
> Standard settings -> Miscellaneous. 
 

 
 

 

Autosave interval: A backup file is made in the SummaFlex Pro directory called autosave.job. 
This option sets with at which interval this file is updated. 
 
Max. number of jobs in history: Sets the number of recent files in the file menu. 
 
Don’t ask for save on exit: Option to close a job without asking if changes need to be stored. 
 
Prompt ‘overwrite file?’ when saving: Sets the option to prompt a window to overwrite an 
existing file or not.  
 
1.4.3 Importing a file 
 
To import a file go to the file menu and click Import. Or double click File import in the side 
bar. When a file is imported, a new job is automatically started (is a setting in the import filter 
setup). 
 

 
FIG 2-17 

2-17 IMPORT WINDOW 
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There are some options in the import window: 
Preview: Show a quick preview of the data in the selected file. 
Insert at position (0,0): Forces the origin of the data to 0,0. This is useful for saving media. 
However, if the option ‘Fit working area to object’ is checked in the general import filter 
settings, then this option is redundant. 
Rotate by:  Is a very useful option to make sure the orientation of the job is adjusted to the 
orientation of the table. 
X-factor and Y- factor: Is a predefined scale factor that can be set, if necessary. 
A second window is then shown with extra import settings with certain import filters 
(e.g.pdf).  
 

 

 
FIG 2-18 

2-18 PAGE SELECTION IMPORT WINDOW 
 
If the file contains multiple pages, then the page to import can be chosen. There are also 
some options for object handling. 
There is the option to ignore or import texts and bitmaps. It is recommended not to import 
the bitmaps. And if they are imported, import them at a low resolution.   
This step (page selection) can be skipped.  
 
If the program recognizes the registration marks, then it marks them with a cross hair in the 
middle of the circle. 
 

 

 
FIG 2-19 

2-19 CIRCLE RECOGNIZED AS REGISTRATION MARK 

 

ATTENTION: The second window is not shown if the Import pdf setting is the option 
to suppress the select page dialogue box while importing pdf files. 

 

NOTE:   If the registration marks need to be set manually, define them as circles with 
the correct diameter (5 mm default/recommended) in the regmark layer in the 
design software. The program SummaFlex Pro can find them easily without 
intervention of the user, provided that the import filter settings are set correctly. 
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Below is a figure explaining the orientation of the table in reference to the screen in 
SummaFlex Pro. The white area is the working area.  The size of the working area is usually 
determined by the objects. 
 

 
FIG 2-20 

2-20 ORIENTATION TABLE/SUMMAFLEX PRO 
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1.5 Output to the Flatbed 
 
1.5.1 Output settings 
 
The default output settings can be set by going to Settings -> Standard settings -> Output 
Parameters. The window that is opened depends on the current opened job. The option 
differs depending on the presence (print and cut job) or absence (cutting only) of register 
marks in the opened job. 
 

 
FIG 2-21 

2-21 OUTPUT WINDOW SUMMAFLEX PRO 
 
The parameters in red are grayed out when registration marks are in the job (print and cut 
job). The parameters in blue (under the separator asterisks with OPOS) are not visible when 
there are no registration marks in the job (cut job only). 
 

 
 
Device: This option shows the current device driver that is linked to the job. Summa F Series 
is the correct driver for the table. 
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Mode: There are three modes to choose from. The chosen mode influences also the visible 
parameters in the output window. 
Output with layer assignment is the default mode and used in most cases.  
Output with layer assignment fixed feed is a mode for a continuous workflow with sheets. 
This is explained in section 2.12. 
Output with layer assignment Tandem: Is a mode used on the large tables only.  It makes it 
possible to load sheets on one side of the table while it is cutting (or milling) on the other 
side of the table. This is explained in section 2.11. 
 

Output Profile: Here it is possible to store different output profiles. This is used to quickly 
change a set of parameters for a specific job. The parameters that are stored in the profile 
are the parameters in the white area of the output window. 
 

Manage Profiles …: Use this to create, alter and save different profiles. 
 

 
 

These are the parameters to cut out multiple copies of the job: 
 
Number of jobs: applies if sheet material is used and if the total number of copies can’t be cut 
in one sheet. This is then used to tell the program the number of sheets that will be used. The 
total number of cut-outs will then be the number of outputs times the number of copies. Do 
not use this parameter when working with a roll.  
Copies per job: Is the number of copies in one output. This is the number of copies on one 
sheet when working with multiple sheets or the total number of copies when working with roll 
material. 
Copy spacing Y direction: Is the distance between the copies in the Y direction. 
Copy spacing X direction: Is the distance between the copies in the X direction.  
The weed border is cut around each copy.  The distance can be set with this parameter. The 
weed border can then be activated in the preview window (not if multiple copies are 
selected). 
 

If the job exceeds the media size, loaded on the table, then it will report that the job will be 
segmented.  
 

 
 

If not, then there will be a report of how many copies will fit in the Y axis direction and how 
many media will be used in the X direction.  
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The different segmentation options are described in section 2.7. 
 

 
 

Only Output tool-assigned layers: Keep this checked in order to make sure that no data is cut 
from layers that have no tool assigned to them. 
Sort before output: Check this if the cut data needs to sorted before it is sent to the table. 
More info on sorting in section 2.6. 
Send design relative to origin: This option is grayed out when the job is a print and cut job. 
This option can be useful to several sorts of media. If not all objects are selected to be cut, 
then the origin of the job is automatically set to the origin of the selection, if this box is not 
checked. If this box is checked, the origin will stay as defined in the job. 
Plot to file: Check this box if the cut data needs to be sent to a file instead of to the table. This 
option can be usefull for troubleshooting.  
Pause after segment: This option is also grayed out when doing a print and cut job. This 
option makes it possible to add a pause after feeding a segment in a cut only job. 
 

The save settings button saves the output settings ( this button has the same function as the 
save button at the bottom of the window). 
 

 
 

These settings relate to the table and loaded media. The size of the loaded media can be 
filled out.  It can also be set by clicking on the ‘Read material’ button. 
 

 
Material: this parameter lets the user choose between roll media and sheet media. 
Vacuum setup : serves to choose between vacuum control of the SummaFlex Program or 
using the standard table settings.  
Park position: Sets the place the carriage parks after one job (or segment of job) is finished. 
You have the choice to set the carriage at the end, in the middle, at a certain coordinate or 
just lift the head after the job is finished. 
Feed after last segment: Determines whether the media is moved forward after processing 
the last segment. 
Extended feed by…: This parameter makes it possible to add an extra feed after a job. This is 
usefully to create an extra space between two cut only jobs. 
 

If a job needs to be segmented, SummaFlex Pro shows a preview of the job before it will send 
the job to the table. This way the user can choose the way the job will be segmented. 
Segmentation is explained in section 2.7. 
 

The rest of the parameters in the white part of the output window is only visible if the job is a 
print and cut job. 
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The Production mode parameter can be set to Manually, Manually-> Production or to 
Production.  
When it is set to Manually, SummaFlex Pro will pause between reading the registration marks 
and cutting the job. This gives the operator time to check the reading of the registration 
marks, if necessary.  
When it is set to Manually-> Production, then the first copy is done in ‘Manually’ mode, all 
further copies are then done without intervention of the operator.  
When set to Production, then it is even not necessary to set the camera above the first mark. 
The table will go to the position to where the last first mark was read. If the first mark is 
there, the job will be done. If the first mark is not there, then the program waits for the 
operator to set the camera above the first mark. 
 

Click Edit to view the different registration mark settings. 
 

 
 

Mark type: SummaFlex Pro can recognize a whole range of registration mark types. You can 
choose the type here.  If a different camera profile needs to be chosen, the Mark type needs 
to be changed (see section 2.10.2). 
 
 

 

Mark recognition: If a very high accuracy is needed, SummaFlex Pro can read the registration 
marks several times. This can be set with this parameter. 
 

On mark read error: If a registration mark is not found, SummaFlex Pro can either ignore it or 
wait for user intervention. If it is set not to wait, make sure that there are enough good 
registration marks available for accurate contour cutting. 
 

Use only group marks for adjustments: This option can be used to assign certain marks to 
certain objects. In this case the program only uses the marks that are grouped with the 
objects in order to cut them out when this option is set active. This is useful when two or 
more jobs on different sheets are cut in one job. This prevents the program to use wrong 
marks (from another sheet). 

 

ATTENTION: The position of the registration mark should always be defined with a 
circle, even if the registration mark has a different shape. This means that all 
registration mark positions will have to be defined twice if the user chooses to use 
marks that are not circles. So, to avoid extra work and to have the highest possible 
accuracy, always use printed circles as registration marks. 



 User’s Manual 

 

Operation  1-29 

  

 
 

Total number of copies is the total number of copies the user wants.  
The number of copies in the X-direction: Sets the number of copies that will be processed in x 
direction.  
The number of copies in the Y-direction: Sets the number of copies that will be processed in Y 
direction (from left to right). 
 

Number of copies in the Y direction is the number of copies the flatbed will cut out from right 
to left. If the total number of copies exceeds the number of copies in the Y direction x the 
number of copies in the X direction, then the media will be fed forward or the flatbed will put 
its head in the park position to load a new sheet. The way the machine behaves is set with 
the material parameter and the feed / no feed button. 
The number of copies in the Y direction needs to be counted exactly by the user. 
The offset between the copies can be set correctly or can be left unchanged. The values are 
then automatically set correctly when the operator guides the camera of the flatbed over the 
next registration mark, when necessary. 
 

 
 

There are 6 compensation methods; they can be split up into two groups.  
The first group can be categorized under best fit. 

Best fit means that the registration marks are read and that the size and shape of the cutting 
lines follow the printed data as close as possible. This means that when the printout is 
scaled, the cut data is also scaled. When a printout is warped, the cut data is also warped. 
There are 3 types. 

Best fit: The program decides for each curve which registration marks are the closest (best 
placed) registration marks to recalculate the shape of the curve to follow the printout. Only 
those marks will then be actually read. 

Best fit (read all marks): All marks are read to make it easier for the machine to find the 
marks. While the marks are read, they are used for determining where to look for the next 
mark. This can be useful on jobs with few large curves where the marks that will be used for 
actual compensation are far apart (large tables) or if the job is scaled or rotated a lot. 
However, the compensation method itself is the same as with the compensation method 
described above: The program decides for each curve which registration marks are the 
closest (best placed) registration marks to recalculate the shape of the curve to follow the 
printout. 

Best fit (smart compensation): Here also all the marks are read. And all the registration marks 
are used for compensation of each curve. If necessary, the curves are even split up so the 
printed line can be followed more or less precisely.  
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The second group of the type fit to job. 

Fit to job means that the shape and size of the cutting lines are fixed and that they don’t 
follow the printed data. The cut data is just positioned in the best position in reference to the 
registration marks. If the cut data is a perfect square, then the cut shape will be a perfect 
square, regardless whether the printout was scaled in one direction or warped. 

Fit to job: The program decides for each curve which registration marks are the closest (best 
placed) registration marks to position the curve above the printout. Only those marks will 
then be actually read. 

Fit to job (read all marks): All marks are read to make it easier for the machine to find the 
marks. While the marks are read, they are used for determining where to look for the next 
mark. This can be useful on jobs with few large curves where the marks that will be used for 
actual compensation are far apart (large tables) or if the job is scaled or rotated a lot. 
However, the compensation method itself is the same as with the compensation method 
described above: The program decides for each curve which registration marks are the 
closest (best placed) registration marks to position the curve above the printout. And then 
use those to position the curve. 

Fit to job (smart compensation): Here also all the marks are read. And all the registration 
marks are used to position each curve.  

The figures on the next page are explaining in detail how the cut data is processed in 
reference to the printout and the read marks.  
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FIG 2-22 
2-22 COMPENSATION METHODS 
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1.5.2 Cutting only 
 

1.5.2.1 Workflow 
 

The workflow for cutting only with SummaFlex Pro is easy. The designs are made in the 
design program. These designs are then exported to a file format that SummaFlex Pro can 
understand and will be opened in SummaFlex Pro. 
SummaFlex Pro is then used for controlling the flatbed. All tool parameters are also 
controlled from SummaFlex Pro. 
 

Design
software

SummaFlex F-SeriesPostscript: PDF, EPS, AI, PS

Specific: CAD: DXF, Corel: CMX
Bitmap: Tiff, Jpg

Specific
cutter Language

 
FIG 2-23 

2-23 WORKFLOW SUMMAFLEX PRO 
 

It is recommended to know in advance which tools will be used on the flatbed cutter. Each 
line can have the tool as property, which will be used later. SummaFlex Pro recommends 
using layers with as name the tool that will be used on the flatbed cutter as particular 
property. If it is not yet certain during the design stage which tool will be used, it is still 
recommended to use layers (with other names, if necessary) to differentiate between 
different tools.  If the used tool is decided later, the tool can easily be assigned to these 
other layer names in SummaFlex Pro. 
If a job is designed with objects in this layer and correctly exported, SummaFlex Pro will 
automatically assign the correct tool to the object. If it is not possible to use layers to assign 
different properties to different cutting lines, colours can also be used to differentiate them. 
Each colour can then be assigned to a certain tool in SummaFlex Pro. 
 

1.5.2.2 Output to the flatbed cutter 
 

 
FIG 2-24 

2-24 JOB IMPORTED INTO SUMMAFLEX PRO 
 

The figure above shows a file, imported into SummaFlex Pro. The side bar shows the macro 
tab. If the sidebar shows something else, click ‘Macros’ at the right side.  
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Check if the objects have been opened in a layer that has a tool assigned to it. If that is the 
case, the tool name is visible next to an icon of that tool. Select, if necessary, a predefined 
parameter set for a specific material for this tool (see section 2.3.4) 
 

 
FIG 2-25 

2-25 CHECK TOOL SELECTION AND CHOOSE MATERIAL PRESETS CUT ONLY JOB 
 

Locate the macro ‘Output to device’ . 
Click the blue arrow or double click the text to send the job to the flatbed cutter. 
The output window will be opened. 
 

 
FIG 2-26 

2-26 OUTPUT WINDOW CUT ONLY 
 
The output window is similar to the window that has been set up while setting the output 
settings (previous section) , apart from the bottom row of buttons. 
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All parameters can be changed here if necessary and also saved as a new default or a new 
profile (for settings in the white area). 
The preview button can be used to preview the job. The job will automatically be previewed if 
the job is segmented (see section 2.7). 
The read material button can be used to read the size of the loaded media if it is not read 
automatically. 
 

 
The cancel button closes the output window without anything being cut. 
Click the output button to start the job. 
 

 

ATTENTION: It is recommended to set up SummaFlex Pro to read the media size 
automatically. Go to Settings -> Standard settings -> Output devices and check the 

box in front of Automatically read the material size.   . 
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1.5.3 Contour cutting 
 
1.5.3.1 General 
 
In general, contour cutting includes the following steps: 
 Create a graphic. 
 Print the graphic (laminate, if necessary). 
 Load the media and register the registration marks. 
 Cut the graphic. 
 
Do not place contour lines along the edges of graphics or the slightest movement in the 
media may result in an unsatisfactory cut. Instead, practice one of the following techniques: 
 Place contour lines just inside the graphics (recommended). 
 Place contour lines outside the graphics. 
 Create thick borders around graphics and place contour lines inside these borders. 
 
1.5.3.2 Workflow 
 
The workflow for SummaFlex Pro (contour cutting) depends on the used RIP. There are 
basically two types. The type where the RIP itself creates a file that will be used in 
SummaFlex Pro and the type where the data for SummaFlex Pro needs to get the data 
directly from the design software. 
 

Design
software RIP

SummaFlex
PRO

Printer
Screenprint

other

F-Series

PDF
EPS
AI
PS
--
Tiff
Jpg

Native
Printer 
Language

cutter Language

OXF
(also iCut format)

 
FIG 2-27 

2-27 WORKFLOW FOR RIP’S THAT EXPORT TO A SPECIAL FILE FOR SUMMAFLEX PRO 
 

Each cutting line can be cut out with a specific tool. The decision to assign a certain tool to a 
certain cutting line can be taken at three possible stages. You can take it either during the 
design.   Properties can be assigned in the RIP process or even just before they are cut out, 
in SummaFlex Pro. It is recommended to place the decision point during the design. The 
recommended method to do this is using layers. It’s also possible that certain programs 
prevent the free choice of the decision point. 
If it is not possible to use layers to assign different properties to different cutting lines, then 
colours can also be used to differentiate them. Each colour can then be assigned to a certain 
tool in SummaFlex Pro. 
If a job is designed with objects in a layer, which has the same name as the tool name in 
SummaFlex Pro, and which is correctly exported, SummaFlex Pro will automatically assign 
the correct tool to the object. If it is not possible to use layers in order to assign different 
properties to different cutting lines, colours can also be used to differentiate them. Each 
colour can then be assigned to a certain tool in SummaFlex Pro. 
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Design
software RIP

SummaFlex
PRO

Printer
Screenprint

other

F-Series

PDF
EPS
AI
PS
--
Tiff
Jpg

Postscript: PDF, EPS, AI, PS
--
Specific: CAD: DXF, Corel: CMX
Bitmap: Tiff, Jpg

Native
Printer 
Language

cutter Language

 

FIG 2-28 
2-28 WORKFLOW FOR RIP’S THAT CAN’T EXPORT TO A SPECIAL FILE FOR SUMMAFLEX PRO 

 

This type of workflow serves for RIPs that do not have an export function to create files that 
can be processed by SummaFlex Pro. In this case it is almost mandatory to work in layers. 
This way certain layers can be exported to files for the RIP to print and other layers 
(preferably already with the correct tool name assigned to it) to files for SummaFlex Pro. 
Currently used tools on the cutting table are: Drag Knife, Kiss Cutting Knife, Cutout Knife, 
Creasing Wheel, Oscillating Knife, various V-cut knives, Router and Rotary knife. If a job is 
designed with objects in a layer, which has the same name as the tool name in SummaFlex 
Pro, and which is correctly exported, then SummaFlex Pro will automatically assign the 
correct tool to the object. 
If it is not possible to use layers to assign different properties to different cut lines, colours 
can also be used to differentiate them. Each colour can then be assigned to a certain tool in 
SummaFlex Pro. 
 
 

1.5.3.3 Output to the flatbed cutter 
 

 
FIG 2-29 

2-29 CONTOUR CUT JOB IMPORTED INTO SUMMAFLEX PRO 
 

The figure above shows a file imported into SummaFlex Pro. The side bar shows the macro 
tab. If the sidebar shows something else, then click on ‘Macros’ at the right side.  
 



 User’s Manual 

 

Operation  1-36 

Check if the objects have been opened in a layer that has a tool assigned to it. If that is the 
case, then the tool name is visible next to an icon of that tool. Select, if necessary, a 
predefined parameter, set for a specific material for this tool (see section 2.3.4). 
 

 
FIG 2-30 

2-30 CHECK TOOL SELECTION AND CHOOSE MATERIAL PRESETS PRINT AND CUT JOB 
 

Locate the macro ‘Output to device’ . 
Click the blue arrow or double click the text to send the job to the flatbed cutter. 
The output window will be opened. 
 

 
FIG 2-31 

2-31 OUTPUT WINDOW PRINT AND CUT JOB 
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The output window is similar to the window that has been setup up while setting the output 
settings (previous section) , apart from the bottom row of buttons. 
All parameters can be changed here, if necessary, and also saved as a new default or a new 
profile (for settings in the white area). 
The preview button can be used to preview the job. The job will automatically be previewed if 
the job is segmented (see section 2.7). 
The read material button can be used to read the size of the loaded media if it is not read 
automatically. 
 

 
The cancel button closes the output window without anything being cut. 
Click on the output button to start reading the registration marks.  
 

 
FIG 2-32 

2-32 REGISTRATION MARKS SEARCH WINDOW 
 
Move the head with the arrows above the first registration mark (the position of the 
registration mark is shown in the preview window at the right). The easiest way is to move 
the head and look at the head itself, do not look at the left preview window yet. Move the 
head, so that the red light of the pointer is situated above the first registration mark.  Then 
move the head a bit forward until the registration mark is visible in the left preview window.  

 

ATTENTION: It is recommended to set up SummaFlex Pro to read the media size 
automatically. Go to Settings -> Standard settings -> Output devices and check the 

box in front of Automatically read the material size.   . 
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SummaFlex Pro will draw a circle around the registration mark if it has been recognized as a 
registration mark. The circle will be green if the center of the circle is within the ‘accurate 
zone’ and red if it is outside that zone. Press enter. 
 

 
FIG 2-33 

2-33 REGISTRATION MARKS SEARCH WINDOW CAMERA OVER REGISTRATION MARK 
 

The flatbed will now search for the rest of the registration marks. If the production mode is 
set to production, the flatbed will start cutting immediately after the marks have been read. If 
production mode is set at manually, then SummaFlex Pro will pause. The recognized 
registration marks will be visible in the right preview window.  
 

 
FIG 2-34 

2-34 ALL REGISTRATION MARKS READ 
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If there is doubt about the correctness of the place of the registration marks, the user can 

check if the marks were correctly read. Each time  is pressed, the table jumps to the 
next mark.  If the mark is accepted by the program, a red check mark is shown at the top 
right side of the mark. The position of the mark is also shown on screen.  If the mark is not 

situated exactly in the middle of the crosshair, the button  can be used to read the mark 
again. If SummaFlex Pro moves the mark it means a new position has been stored. 
 

 
FIG 2-35 

2-35 CORRECTION AFTER RE-READING THE REGISTRATION MARK 
 

If the size of the job (without copies) is larger than the loaded media size, the program will 
choose the size of the segments itself. The size of the different segments will not necessarily 
be the same.  It will depend on the number and positions of the marks. It is also possible that 
SummaFlex Pro will advance the media before it will start reading the mark, if this will 
optimize the size and positions of the segments. 
 

 
FIG 2-36 

2-36 SEGMENTATION PREVIEW 
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1.6 Sorting 
 

Click the blue arrow or double click the text of the sorting macro to start the sorting preview 
(see section 2.2.5.1.). 
A window will open, the selected objects can be made visible by clicking on the play button. 
The objects will be drawn as they are stored in the file. 
 

 
 

 

In the left side of the window are the general selection options and 
the option to show the selected objects before sorting or not in the 
upper right part of the window. 
There is the option to choose all layers to sort together or to sort 
layer per layer.  It is recommended to make the selection before the 
sorting window is open.  Make sure all objects, which are cut with 
the same tool, are selected.  Then sort them all together, whether 
they are on one layer or not. 
For ‘view complete path’ see below. 

 

There are two basic sorting methods. Sorting by main direction, or sorting by nearest 
objects. Both sorting methods have their own specific parameters. 
The sorting method that will be used when the sorting option is set on in the output window 
will not change if the sorting method is changed in this window. Unless one of the buttons 
‘apply settings for output’ or settings for output is clicked. 
 

 

This gives the user the choice in which 
direction the program has to sort. Several 
options can be tried out to check which one has 
the shortest path length. The shorter the path 
length, the faster the job is cut.  
Max deviation is the maximum distance (in 
either X or Y direction) the objects may be 
situated before this option is selected in the 
sorting algorithm. 
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This sorting method will always look for the 
nearest object to determine the order in which 
the objects are cut. One option is to leave the 
origin points as they are.   Let them all start at 
the same position or let the program change 
the start point to minimize the ‘up’ movements 
of the tool. 

 

 

The path length is the distance the tool has to travel in the up 
position to complete the objects that are currently selected. This 
is a clear indication of the time that will be ‘lost’ during the job. 

 

 

These are the buttons that control the sorting itself. Click Sort to 
apply the chosen sorting method to the objects. Click Reset to get 
the objects in their original order. Click Apply settings for output 
to copy the current sorting method to the default sorting method 
when sorting just before the output is activated (see output 
dialogue window). Click Settings for output see below. 

 

 

 
This window is used to set the default 
sorting method when sorting just before 
output is activated. 
When the box in front of ‘Sorting settings 
for registration marks’ is not checked, then 
the sorting order for the objects to be cut 
can be set. When the box in front of 
‘Sorting settings for registration marks’ is 
checked, then the sorting order of the 
registration marks can be set. 

 

 

 

This can be used to show the order on the 
screen, in which the objects will be cut. The 
slider can be used to raise or lower the 
speed at which the preview is shown. 

 

NOTE:  After each sorting check the path length value (bottom left in the sorting 
window). If this value increases, a wrong sorting method has been chosen.  In this 
case either cancel the sorting or sort differently. There is no specific sorting option 
that is always best to optimize the order of the objects.   It depends on the job and 
the way the objects are placed in it. 
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1.7 Segmentation 
 
When the job is larger than the length of the table, SummaFlex Pro will divide the job into 
segments. Before the program starts sending the data to the table, a preview will be shown. 
There are a couple of options for defining the size and places of the segments. If an option is 
chosen, a preview will be shown with the place of the segment lines (= segment size). They 
can then be changed, if necessary.  
 

 
FIG 2-37 

2-37 SEGMENTATION OPTIONS 
 

 
 
Optimize material (max. size + smallest at last). This is normally used when the job is cut 
from a roll and if it does not matter where the segments are defined. The segments have the 
maximum size and the last one is the smallest one. 
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Optimize material (max. size + smallest at first). This is normally used when the job is cut on 
a sheet and if the end of the media is 37 cm or less after the last segment line.   This way the 
machine cannot feed the media forward correctly.  Therefore, it is better the last segment is 
37 cm or larger. If the option smallest first is chosen, the last segment always has the 
maximum size, so there is enough media to feed forward correctly. 
 

 
 
This option tries to set the segment lines this way the objects can be cut without them being 
segmented.  SummaFlex Pro suggests a segment line and shows which objects will be cut per 
segment. The preview above clearly shows that in some places the table cuts further then the 
segment line.  However, in this case this part of the object will not be cut in the following 
segment.  In the above example the ‘A’ of summa is completely cut in the first segment and 
the machine does not cut any part of the ‘E’ in series. Then the media is moved forward and 
nothing of the ‘A’ is cut, but the complete ‘E’ will be cut in the second segment. This way the 
objects always close better than if they would have to be cut in segments. 
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This option divides the entire job into equal parts. This can be useful when the jobs will have 
to be applied on different panels, which have the same size. 

 
The fifth option is selectable if a job has already been cut. The type of segmentation was then 
automatically saved and the same type can then be chosen when this option is selected. 
 
“Reverse cutting” is for cutting out ‘the negative’ such as for making templates for screen 
printing.  
The overlap repeats the data of the previous segment in the following segment over the 
chosen distance. 
This option can only be used if the segments will be applied separately. 
The overlap is then the amount that the separate segments will be applied over one another. 
If the design must stay in one piece, then the overlap value must be set to 0. 
 

 
 

NOTE: When doing print and cut jobs, the segments are set by SummaFlex Pro. This 
is done to optimize the mark position in reference to the segments. 
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1.8 Most used actions in SummaFlex Pro 
 
This section explains in detail the most used actions in SummaFlex Pro. 
 
1.8.1 Change the assigned tool (changing objects from layer) 
 
If an object is situated in a certain layer, it will be cut with the tool that is assigned to this 
layer. If the object needs to be cut with another tool, there are two possibilities. Or the 
properties of the layer can be changed, or the object can be moved to the layer that has 
already been set up for the tool. 
It is recommended to use the last option. 
 
Procedure to change the assigned tool (change the object from one layer to another): 
 

• Select the objects. 
• Click the dropdown box at the top and select the destination layer. 
• Click the green icon next to the layer that has just been chosen. 

 

 
FIG 2-38 

2-38 CHANGE THE OBJECT FROM THE LAYER 
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1.8.2 Most used commands in the view menu 
 
The view menu has a couple of very handy commands. Click View to show the commands. 
 

 
FIG 2-39 

2-39 CHANGE THE OBJECT FROM THE LAYER 
 
Fit page to object: SummaFlex Pro adds a border from 2 mm by default around imported 
objects. This is very handy in most cases, especially when contour cutting. However in cases 
where the page size is very important (e.g. for multiple copies that need to touch) it is 
necessary that the page size (or bounding box) is exactly the same size as all the objects. 
Click ‘fit page to objects’, so that the page size is reset.  This can also be useable when the 
file has been altered in SummaFlex Pro itself (absolutely not recommended for contour 
cutting). 
 
Contour View: Selecting this removes fills from objects and only shows the outline. This can 
also be useful for routing applications where the routing path is shown by default as a thick 
line (the thickness is the size of the router bit). Sometimes this will hide details (e.g. start 
paths). 
 

 
Show object orientation: If this option is selected, the beginning of each curve is marked with 
a triangle, which also shows the direction of the curve. 
 
Enhanced view: If this option is chosen, the objects are shown the best possible way 
(smoothed). This slows down the speed when rebuilding the view and should thus only be 
used for presentation.  

 
NOTE:  The orientation of the curve can easily be changed just by clicking the arrow. 



 User’s Manual 

 

Operation  1-47 

1.8.3 Optimizing material (simple nesting) 
 
A possibility exists to rearrange the objects that need to be cut in SummaFlex Pro, so that 
less material is used.  
This nesting option is a simple nesting algorithm.   It first puts each object in a bounding box 
and then it nests the bounding boxes.  If a more complex nesting option is needed, an extra 
software module needs to be bought. 
 

 
To optimize the positions of the objects make sure they are selected and go to tools optimize 
material. After that the Optimize windows opens. 
 

 
FIG 2-40 

2-40 SIMPLE NESTING 
 

1. Weed border: Is the distance that will be kept between objects. 
2. Rotate objects to shorter side: All objects are rotated, so the shorter side points 

downwards. 
3. Rotate as needed: During optimization all objects are rotated, so they can be 

arranged, saving most of the space. 
4. Only selected objects: Only the selected objects are optimized. With this option you 

can optimize according to layers (colours). 
5. Maximum optimization: If this option is activated two more fields are shown. The 

option Maximum Optimization calculates more possible combinations that can arise 
to end up with maximum optimization. Optimizing can take much time depending on 
the size of the objects and the set values. Therefore, do not set used values higher 
than 20-30 for the amount of objects and with an optimization level of maximum 5. 

 

 
NOTE:  Do not use optimizing material if it is a print and cut job.  Nesting is for cut 
jobs only. 
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1.8.4 Configuring output profile 
 
Settings in the output window can be saved in Profiles. This in order to avoid, having to 
change certain settings in the output window. Below you can find an example on how to do 
this. In this case a profile is made for jobs that use sheet material, need a special camera 
profile for the markers and with no pause between reading the markers and cutting. 
 
1. Open a job and go to the output window (go to File -> Output… Or use the Output to 

device macro). 

1. Click Edit next to Mark settings and change it to User defined. 

 
FIG 2-41 

2-41 SET THE REGISTRATION MARK TO USER DEFINED 
 

2. Click Roll next to Material and choose sheet. 

 

FIG 2-42 
2-42 SET MATERIAL TO SHEET 

3. Click Manual-> Production next to production mode and choose production. 

 

 

FIG 2-43 
2-43 SET PRODUCTION MODE TO PRODUCTION 

 
4. Click Manage profiles and choose Add. 

 

FIG 2-44 
2-44 SAVE AN OUTPUT PROFILE SETUP 

 
5. Choose a name which clearly explains the profile, fill it out and click OK. 

6. Perform the first job and change the camera profile as described in section 2.10.2. After 
the job is done, the camera profile will automatically be linked to the profile.  
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1.8.5 Cutting from the backside 
 
1.8.5.1 Using the plug-in for Corel or Illustrator 
 
This procedure is for cut jobs only, not for milling jobs. Some jobs require they are cut from 
the none-printed side. For this purpose a plug-in for Corel and Illustrator exists, which works 
well in combination with a macro in SummaFlex Pro. 
 
Procedure to cut from the backside: 
 
1. Make sure the print data is situated on a separate layer and the cut data on the correct 

cut layers. 

2. Use the plug in ‘Add SummaFlex Pro marks and cut out squares’.  

 

FIG 2-45 
2-45 PLUG-IN FOR CUTTING FROM THE BACK SIDE (COREL AND ILLUSTRATOR) 

 
3. Print out the print layer and the Regmark layer (do not print out the Cut out Square 

layer). Make a pdf file of all the cut layers, the Regmark layer and the Cut out squares 
layer to open In SummaFlex Pro. 

4. Leave the objects in the cut out squares layer and assign a tool to that layer. This tool will 
most likely be the same tool that will be used to cut from the backside. Make sure the 
parameters of this tool are set correctly for the type of material that is loaded on the table 
(use the gears icon or a media profile if one was set up). 

5. Click Cutting from the Backside macro. . 

6. In the output window, check if the marker type is set to ‘symmetrical’ or use a special 
output profile where this parameter is already preset to this value (see section 2.8.4). 

 

FIG 2-46 
2-46 SET PRODUCTION MODE TO PRODUCTION 

 
7. Click output. Place the camera over the first mark and click OK. The table will now read all 

the markers and cut out the squares. 

8. When prompted by the program, turn the sheet over with the print side down, as shown in 
the figure below (watch the markers closely to see the orientation.  They are cut 
completely through). 
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FIG 2-47 

2-47 TURN THE SHEET ON THE TABLE (MIRROR IN Y DIRECTION) 
 

 
9. After that continue with the macro as prompted on the screen. 

 
1.8.5.2 Cutting/Milling from backside general procedure 
 
Most RIP’s set the print and cut marks themselves, so the procedure with the plug-in for 
cutting from the backside cannot be used in this case. The procedure below describes what 
to do in this case. 
There are 2 pairs of macro’s for cutting/milling from the back side. One set for cutting and 
one set for milling. The set for cutting consists out of the macro ‘place squares’ and ‘cutting 
from the backside’. For milling use ‘Place squares’ and ‘Milling from the Backside’. 
 
 
1. Open the OXF file from the RIP in SummaFlex Pro. 

2. Select all the registration marks ( click on the little blue icon next to the Regmark layer). 

 

3. For cutting Click on the macro ‘Place Squares’, for milling Click on the macro ‘place 
circles’. 

4. Check the tool and its settings for the correct object (Cut Out Squares for cutting or Cut 
Out Circles for milling).  Adjust the tool and /or the tool properties, if necessary. 

 

 
NOTE:  Look closely at the markers, they should be considered as cut out and show 
how the orientation of the flipped sheet looks like. 

 
NOTE:  If the default values for the Cut Out Squares or Cut Out Circles layer need to 
be changed, then see section 1.2.5.2 . 

  

printout 
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5. Click ‘Cutting from the Backside’ macro.  for cutting 

or click on ‘Routing from the backside’ for milling . 

6. In the output window, check if the marker type is set to ‘symmetrical’ or use a special 
output profile where this parameter is already preset to this value (see section 2.8.4). 

 

 

FIG 2-48 
2-48 SET PRODUCTION MODE TO PRODUCTION 

 
7. Click output. Place the camera over the first mark and click OK. The table will now read all 

the markers and cut out the squares or mill out the circles. 

8. When prompted by the program, turn the sheet over with the print side down, as shown in 
the figure below (watch the markers closely to see the orientation.  They are cut 
completely through). 

 

 
FIG 2-49 

2-49 TURN THE SHEET ON THE TABLE (MIRROR IN Y DIRECTION) 
 

 
9. After that continue with the macro as prompted on the screen. 

 
 
 

 

NOTE:  Look closely at the markers, they should be considered as cut out and show 
how the orientation of the flipped sheet looks like. 

  

printout 



 User’s Manual 

 

Operation  1-52 

 
1.8.6 Segment helper 
 
The option segment helper is an option to compensate small errors when cutting in panels. 
This is used when doing cut only jobs or with contour cutting unstable media (for instance 
fabric). 
This is a parameter that has to be set on or off per layer. 
 

 
FIG 2-50 

2-50 SEGMENT HELPER 
In the layer set the segment helper on or off.   Clicking on the status toggles it.  
 
The size of the segment helper is 3 mm in both X and Y direction. Below is a detail of how the 
segment helper looks like. X in the figure is the segment helper X size (amount further cut in 
first panel) Y is the segment helper Y size (size of the ‘cross’ segment) also cut in the first 
panel. The black line is then cut in the following panel. 
 

x

y  
FIG 2-51 

2-51 SEGMENT HELPER 
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1.8.7 Getting rid of ‘double’ objects 
 
When objects are twice defined in a file, then there is a quick procedure to get rid of those 
“doubles”.  
Below a figure with apparently 16 objects. 

 

16 objects are seen; the program counts 24 objects, so double objects are suspected.  
Click Tools -> Welding, choose dialogue. It is possible that the program asks if the lines’ 
thickness needs to be converted into separate curves.  Leave the box unchecked and just 
click OK. 
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The dialogue window in the manual welding can even be used to get rid of double lines which 
are not defined exactly one above the other but very close to one another. The minimum 
distance to be taken in account can be set. Change the value, if necessary, and click Weld. 

 

Finally go to Design -> Close Contour, because the program splits up the curves in vectors 
while it welds them. 

 
 

 

 

 
NOTE:  This procedure can be useful in other cases of bad data also. If the cutting 
result shows strange behavior, then try this procedure. 
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1.8.8 Set Marks 
 
All registration marks must be defined as circles for SummaFlex Pro to be able to recognize 
them as a mark. The printed shape, however, can be something else.  
If the file with the cut data has the printed (none circle) marks as definition for the place of 
the marks, then SummaFlex Pro has some handy shortcuts to create the necessary marks on 
the correct place. 
Do not forget to change the Mark settings (Mark type) in the output window (section 2.5.3.3). 
 
Case 1 Marks are Summa OPOS marks (or general symmetrical marks): 
 
Data file has wrong marks  

 
Select the marks and go to Plug-ins Objects Replacer 

 
In the Window choose to replace the objects by Video marks. Check other options, if 
necessary (e.g. delete original objects). 

 
The program will now replace all the squares by circles and delete the squares.  Give it as 
property ‘video mark’ and it will put all those objects in the Regmark layer. 
 

→ Mark settings in the output dialogue will have to be set to ‘symmetrical objects’. 
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Case 2 None symmetrical marks: 
 
The data file contains wrong marks (crop marks in this case). 

 
 

Go to edit nodes (see section Error! Reference source not found. Macro tabs). Select 
node(s) (hold shift key down for selecting multiple nodes) where a mark is printed. Right 
click Create video mark at the selected nodes. 

 
Afterwards, delete the marks manually.  Otherwise they will also be cut out. 
 

→ Mark settings in the output dialogue need to be set as ‘crop marks’. 
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Case 3 No Marks printed: 
 
If no marks are printed, then it is usually not possible to cut the job afterwards. However in 
some cases it is possible that clear unambiguous cornered shapes with high contrast, printed 
in the job, can be used as mark position. For instance, if there is a text printed in the job with 
a font that has sharp corners. An example is given below. 
 

 
Go to edit nodes (see section Error! Reference source not found. Macro tabs). Select 
node(s) (hold shift key down for selecting multiple nodes) where a mark is printed. Right 
click on click on Create video mark at selected nodes. (the selected nodes are marked here 
with an arrow to show which possible points can be selected as places for marks). 
 

 
 

→ Mark settings in the output dialogue will have to be set to ‘crop marks’. 
 

 
 

 

NOTE:  The three above procedures are ‘salvage’ procedures.  They should not be 
considered as a normal workflow.  However, they can be used to save otherwise lost 
printouts. 
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1.9 Router module settings in SummaFlex Pro  
 
Milling is more than just ‘cutting’ one line. With the miller there are several possibilities. If the 
job consists out of milling shapes, then ‘dynamic routing’ can be used. If the jobs are more 
complex, SummaFlex Pro has to calculate the routing paths (see section 2.9.4). 
There are also a couple of extra things the user will have to decide on.  These things are 
mostly media dependent. 
There is the orientation. This is explained in section 2.9.3. 
The user will also have to decide if the job will be milled in one pass or in several passes. This 
can be done by using either the milling layer or the milling multipass layer. Here the bit 
diameter plays a significant role.  
 

 
1.9.1 Dynamic routing 
 
If the job is just cutting out shapes, then the only parameters SummaFlex Pro needs are the 
router bit diameter and the orientation it needs to route. Those two parameters can be set 
when setting up the layer for milling (both single pass and multipass). If those parameters 
are set, the routing path is shown as a thick outline (thickness = routing bit diameter).  If 
SummaFlex Pro is set in contour view (see section 2.8.2), then the original line will be 
changed into a dashed line and the routing path will be shown as a thin line in the same 
colour.  
 

 
FIG 2-52 

2-52 DYNAMIC ROUTING LEFT SIDE NORMAL VIEW RIGHT SIDE CONTOUR VIEW 
 
 

 

ATTENTION: 
1. The recommended maximum milling depth per pass is 1.2 times the router bit 

diameter. 
2. The recommended maximum complete milling depth (media thickness) is 3 times 

the router bit diameter.  
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1.9.2 Setting up layers for routing 
 
1.9.2.1 Setting up the layer and parameters for milling  
 
Setting up this layer is similar as described in section 2.3.  
 

 
FIG 2-53 

2-53 LAYER SETUP MILLER 
 

There are eleven parameters for the miller, divided in three sets: 
 
General parameters 
 
1. HF Router speed (10000-48000RPM): This is the speed of the HF miller motor. This 

setting is ignored if the standard router is used. 

2. Speed (mm/s): This is the speed at which the router moves. Reduce this speed for thicker 
materials. 

3. Down position offset (mm): The milling depth can be adjusted with this parameter. This 
parameter can only have positive values. The maximum milling depth is calibrated with 
Axis Control. This parameter can be used if the router has to mill less deep than the 
calibrated depth. 
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Dynamic routing parameters 
 
4. Dynamic tool parameter compensation: This parameter sets whether the routing path will 

be on the defined line, or at an offset to it (the offset will be half the diameter of the 
routing bit – see further). 

5. Tool diameter (mm): Here the diameter of the routing bit is set. 

 
6. Change bit before routing: If this is set to on, then the table will pause just before it starts 

with this layer to give the user the possibility to change the routing bit. This parameter 
cannot be used if there is no ADC installed on the table. 

7. Tool diameter compensation: This parameter determines whether the routing path will be 
defined inside or outside the object. However, if objects are defined one into another, then 
the routing path switches from side for the objects that are inside another object. The 
picture below illustrates this. 

  

FIG 2-54 
2-54 COMPENSATION IS SET AT OUTSIDE 

 

FIG 2-55 
2-55 COMPENSATION IS SET AT INSIDE 

 

8. Tool diameter compensation for open objects: If there are lines in the design, which are 
not closed, then they usually need to be routed on the line itself. Use this parameter to set 
it up like this. If the routing path is routed at an offset of an open object, then the routing 
line will be under or above the line according to the direction of the line segments of the 
line. 

Other parameters: 
 
9. Orientation: This sets the orientation of the routing path. This parameter is media 

dependent and is best tested out first. (see section 2.9.3) 

10. Start tool path: If this option is activated, the tool will use a circular arc movement 
towards the curve that needs to be milled, unless there is a line in the curve.  In that case 
it will start at that point. 

11. Pause after tool: If this option is activated, the machine pauses after the use of this tool. 

 

 
ATTENTION: The tool diameter has to be set to 0 if the routing path was already 
defined in the design. 
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1.9.2.2   Setting up the layer and parameters for milling multipass 
 
Setting up this layer is similar as described in section Error! Reference source not found.. 
 

 
FIG 2-56 

2-56 LAYER SETUP MILLER MULTIPASS 
 

There are seventeen parameters divided in 4 sets for the milling multipass. 
 
General parameters: 
 
1. HF Router speed (10000-48000RPM): This is the speed of the HF miller motor. This 

setting is ignored if the standard router is used. 

2. Speed (mm/s): This is the speed at which the router moves. Reduce this speed for thicker 
materials. 

3. Material thickness (mm): Is the total media thickness. 

4. Milling depth (mm): Is the depth that needs to be milled. This is usually the same value as 
the media thickness. 

5. Max depth per pass (mm): Thick materials cannot be milled in one pass; the parameter 
sets the maximum depth per pass. 
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Parameters for last pass: 
 
The last pass can be used as a cleaning pass (see section 2.9.4.5). If dynamic routing is 
used, then use these parameters to configure the last pass. 
 
6. Speed of the last pass: With this parameter the speed of the last pass can be set. A lower 

speed can result in smoother finishes. This speed setting is normally used when the last 
pass is used as a finishing pass. Refer to the routing bit tables of the routing bit 
manufacturer for commonly used settings. 

7. Depth of last pass (mm): This is the milling depth of the last pass. SummaFlex Pro 
calculates the amount of passes it needs, depending on the values of the milling depth, 
the maximum depth per pass and the depth of the last pass. 

 

 

 
8. Cleaning path: This sets the cleaning path on or off.  If the value is set to on, the last pass 

becomes the cleaning path. It is used to get a better finish for routing and is also used 
when routing relatively small objects. However, if a value is set to on, all the passes before 
the last pass are milled at an offset. 

9. Cleaning path offset in %: This sets the size of the offset of the other paths to the cleaning 
path. (Absolute value is the % value of half the tool diameter). 

 

 
Dynamic routing parameters: 
 
10. Dynamic tool parameter compensation: This parameter sets whether the routing path will 

be on the defined line, or at an offset to it (the offset will be half the diameter of the 
routing bit – see further). 

11. Tool diameter (mm): Here the diameter of the routing bit is set. 

 
12. Change bit before routing: If this is set to on, then the table will pause just before it starts 

with this layer to give the user the possibility to change the routing bit. This parameter 
cannot be used if there is no ADC installed on the table. 

 

 
NOTE:  If the last pass does not need special settings, then set the value at 0.  

 

NOTE:  Milling exerts large forces on the piece that is routed. Therefore, the 
thickness of the last pass is relatively small. Small enough so the forces exerted 
during routing are not too large, but still large enough, so the milled piece remains 
fixed until it is completely milled. Commonly used values are between 0.5 and 1 mm. 
These values are dependent on the material that is milled, the diameter of the routing 
bit and the setting of the routing bit’s depth.  

 
ATTENTION: The tool diameter needs to be set to 0 if the routing path was already 
defined in the design. 

 

ATTENTION: The tool diameter needs to be set to 0 if the routing path was already 
defined in the design. 
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13. Tool diameter compensation: This parameter determines whether the routing path will be 
defined inside or outside the object. However, if objects are defined one into another, then 
the routing path switches from side for the objects that are inside another object. The 
picture below illustrates this. 

  
FIG 2-57 

2-57 COMPENSATION IS SET AT OUTSIDE 
 

FIG 2-58 
2-58 COMPENSATION IS SET AT INSIDE 

 

14. Tool diameter compensation for open objects: If there are lines in the design, which are 
not closed, they usually need to be routed on the line itself. Use this parameter to set it up 
as such. If the routing path is routed at an offset of an open object, then the routing line 
will be under or above the line according to the direction of the line segments of the line. 

Other parameters: 
 
15. Orientation: This sets the orientation of the routing path. This parameter is media 

dependent and is best tested out first. (see section 2.9.3). 

16. Start tool path: If this option is activated, the tool will use a circular arc move towards the 
curve that needs to be milled, unless there is a line in the curve.  In that case it will start 
at that point. 

17. Pause after tool: If this option is activated, the machine pauses after the use of this tool. 
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1.9.3 Routing orientation 
 
The routing orientation is a parameter that is media dependent and that influences the 
milling quality substantially. It also affects the life time of the routing bit. Always try and 
follow the recommendations of the manufacturer of the media or routing bit. When this info is 
not available, try both settings (CW and CCW) and check the quality. When objects are 
defined inside other objects and they are selected together for calculating a routing path, 
SummaFlex Pro alternates inside and outside and clockwise and anticlockwise when the 
routing path is calculated. It makes no difference if the objects are grouped or not or if they 
are combined or not (SummaFlex Pro un-combines objects by default to get a higher 
accuracy for cutting). The changing of the orientation is necessary, so the inside is milled the 
same way as the outside (climb milled or conventionally milled). 
 

 

 
FIG 2-59 

2-59 CLIMB – “DOWN” MILLING (CLOCKWISE) 

 
FIG 2-60 

2-60 CONVENTIONAL – “UP” MILLING (COUNTERCLOCKWISE) 
 

 

NOTE:  As a rule, metals are climb milled and (soft) plastics are conventionally milled. 
However, aluminum covered sandwich board is conventionally milled and some hard 
plastics are climb milled when the  router bits are smaller than 4 mm. 



 User’s Manual 

 

Operation  1-65 

 

1.9.4 Different routing applications 
 
Apart from the dynamic routing, there are other router applications possible. This section 
explains the different routing possibilities. 
 
1.9.4.1 Calculating the inside or outside path 
 
In order to mill an inside or outside router path, follow the below procedure. 
 
10. Select the objects, of which the paths will have to be calculated. Then go to Tools -

>Milling/Hatching or type ‘f’ 

 
FIG 2-61 

2-61 CALCULATING THE ROUTING PATH 
 

11. A window with the routing options is shown. When calculating an inside or outside 
routing path, then only the right side of the window is used. First choose the inside or 
outside routing path. Then choose the adjustment layer. 

 
FIG 2-62 

2-62 ROUTING PATH OPTIONS 
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FIG 2-63 

2-63 INSIDE ROUTING PATH CALCULATED 
 

FIG 2-64 
2-64 OUTSIDE ROUTING PATH CALCULATED 

 

1. Tools diameter:  The thickness of the router bit needs to be filled out here, so the 
program can make the correct calculations. 

2. Adj. layer: This is the output layer for the routing path.  Choose between milling 
multipass or milling, depending on the thickness of the material. 

3. Layer inf: The layer name can be altered but the new layer will still use the milling 
tool. This is useful if a difference has to be made between milling layers (e.g. for 
different parameter settings for the miller). 

4. None: This radio button is grayed out if the option inside or outside path is chosen. 

5. Adjustment: Check this radio button if the side of the routing path has to be exactly 
on the object contour line. 

6. Adj value: Check this radio button if an extra offset between the routing path and the 
object contour line is needed. The filled out offset will be an offset between the 
center of the routing bit and the contour line of the object. 

7. Orientation: Choose the orientation of the routing path.  

8. Fixed size: If this option is checked, the size of the new created routing path cannot 
be altered any more. 

9. Fixed size for output:  If this option is checked, the size of the new created routing 
path will not be changed when doing print and cut.  Only the position of the object to 
the printed register marks will be adjusted. 

When two different milled parts have to fit exactly in one another, the corners will have to be 
rounded before the routing path is calculated. Select the objects (corners) that need to be 
rounded. Go to Design  Round corner (Shift Ctrl R). When choosing the radius, be sure that 
this is a bit larger than the radius of the routing bit. 
 

 
FIG 2-65 

2-65 ROUNDING CORNERS 
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1.9.4.2 Calculating a hatch or island fill 
 
An island or hatch fill arises when an object is filled and then milled.  This can be used to 
emboss objects or text or to create a hole for an inlay. 
 
1. Select the objects, that need to be filled. Then go to Tools ->Milling/Hatching or type ‘f’ 

 
FIG 2-66 

2-66 CALCULATING THE FILLING AREA 
 

2. A window with the routing options is shown. First choose the filling type (hatch or island). 
The figure below shows the difference between an island fill and a hatch fill. The routing 
paths are shown as a yellow line in the objects. 

 

  

FIG 2-67 
2-67 ROUTING PATH HATCH FILL 

 

FIG 2-68 
2-68 ROUTING PATH ISLAND FILL 

 

3. First set up the layers.  The target layer is the layer where the fill will be created in. The 
adjustment layer is the layer in which the routing path around the fill we be created if an 
offset (adjustment) is chosen. If the option ‘None’ in the path adjustment options is 
chosen, the routing path around the fill will be created in the same layer as the fill and it 
will be created with the center of the bit on top of the outline contour of the object. 
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FIG 2-69 

2-69 FILLING OPTIONS 
 

1. Tools diameter: Here the thickness of the router bit needs to be filled out, so the 
program can make the correct calculations. 

2. Target layer: This is the output layer for the routing path of the fill.  Choose between 
milling multipass and milling, depending on the thickness of the material. 

3. Hatch angle: The angle of the hatch lines can be changed with this parameter. 

4. Delete original:  If this option is checked, the original object will be deleted if the fill 
has been created. 

5. Pocket connection: This can be used to reduce the number of up/down movement 
during milling.  If this option is checked, the miller will not be raised between the 
different lines of the hatch fill or the different ‘contours’ of the island fill. 

6. Optimize: This option might shorten the milling time and is used in combination with 
pocket connection.  However, it might lower the milling quality. 

7. Overlap: This sets the overlap between the hatch lines or islands contours (in % or 
absolute). 

8. Adj. layer: This is the output layer for the routing path (analogue to target layer). 

9. Layer inf.: The layer name can be altered but the new layer will still use the milling 
tool. This is useful if a difference needs to be made between milling layers (e.g. for 
different parameter settings for the miller). 

10. None: Already explained when setting layers. 

11. Adjustment: Check this radio button if the side of the routing path needs to be 
situated exactly on the object’s contour line. 

12. Adj. value: Check this radio button if an extra offset between the routing path and the 
object contour line is needed. The filled out offset will be an offset between the 
center of the routing bit and the contour line of the object. 

13. Orientation: Choose the orientation of the routing path.  

14. Fixed size: If this box is checked, the size of the new created routing path cannot be 
altered any more. 

15. Fixed size for output: If this box is checked, then the size of the new created routing 
path will not be changed when doing print and cut. 
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1.9.4.3 Embossing text (or objects) 
 
When SummaFlex Pro does a fill of object 1 and there is a closed object 2 in this fill, then this 
object 2 will not be filled. However, if there is another object 3 in object 2, this object will be 
filled.  The same happens for all the objects inside. Below is a picture showing 4 objects into 
one another and showing how SummaFlex Pro will fill them. 
In the example below, the fill was island fill and the overlap was set greater than the router 
bit size in order to show more clearly what happened. These are not settings that will be used 
in production but merely settings to clarify how the filling works. 
 

 
FIG 2-70 

2-70 FILLING OBJECTS IN OBJECTS 
 

So when text needs to be embossed, just put a rectangle around it. In the sample below the 
fill was set to hatch fill and the overlap was set greater than the router bit size in order to 
show more clearly what happens (see remark above). The difference can be seen when the 
text has a rectangle around it or not. 
 

  

FIG 2-71 
2-71 TEXT WITH RECTANGLE AROUND IT 

 

FIG 2-72 
2-72 TEXT WITHOUT RECTANGLE AROUND IT 
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1.9.4.4 Creating bridges 
 
Sometimes small parts move during routing. This affects the overall quality. In order to avoid 
this, small ‘bridges’ can be created to hold those small pieces in place. 
To create a bridge, follow the below procedure. 
 
1. Select the routing path (click on routing path). Select to edit nodes (use macro ‘edit 

nodes’ in the macro tab, see section Error! Reference source not found.). Then select a 
node where the bridge needs to come (click on the node), or add a node (right click on 
the routing path and choose add) if there is no node in the area where the bridge needs to 
come.  Select that one (click on the new node). 

 
FIG 2-73 

2-73 INSERTING A NODE 
 

2. Check in the standard settings menu under the settings menu if the size of the bridge is 
set correctly.   If not, change it. 

 
FIG 2-74 

2-74 SET THE BRIDGE SIZE 
 

3. Right click on the selected node and choose to add bridge. The result is a routing path 
that is interrupted. 

 

  

FIG 2-75 
2-75 INSERT BRIDGE 

 

FIG 2-76 
2-76 RESULT 
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1.9.4.5 Cleaning pass 
 

 

It is recommended to have a final pass with a thickness of +/- 0.5 mm, 
even if the bit could route the material in a single pass. If the final pass 
has less material to remove, the dust extraction system will be more 
effective and the table will be cleaner after the job. A general difficulty 
when routing completely through a material is that pieces are moving on 
the table and are hit by the routing bit. A small finishing pass keeps all 
pieces in place until the last pass. And as the last pass contains limited 
material only, the used forces are less and the risk that pieces move is 
smaller. The cleaning pass is visible in red in the figure to the left. 

If dynamic routing is used, a cleaning pass can be set with the tool parameters in the layer 
setup. However, if the routing paths are defined manually, the parameter settings of the last 
pass are more flexible (separate speed settings, separate bridge definition,..) 
 

1. Select the objects whose paths will need to be calculated. Then go to Tools -
>Milling/Hatching or type ‘f’. 

 
FIG 2-77 

2-77 CALCULATING THE ROUTING PATH 
 

2. A window with the routing options is shown. Choose the path adjustment (inside or 
outside)  and set the tool diameter. Then choose the adjustment layer (milling or milling 
multipass, depending on the thickness of the material).  Click the radio button next to Adj, 
value and fill out a value, which is higher than half the diameter of the router bit (r+ 0.3 to 
r+0.5).   Choose the router direction (CW or CCW). Click OK. 

 
FIG 2-78 

2-78 CALCULATING THE ROUTING PATH 
3. Select the objects, whose paths will need to be calculated again. Go to Tools -

>Milling/Hatching or type ‘f’. A window with the routing options is shown. Choose the 
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same setting as in step 2, apart from the adjustment layer.   This now needs to be milling.  
Click the radio button next to adjustment, so that the offset is set again on half the tool 
diameter. 

 
FIG 2-79 

2-79 CALCULATING THE CLEANING PASS 
 

 

 

4. Set the parameter Down Position Offset in the layer set in step 3 to a value between 0.5 
and 1 mm. 

 
FIG 2-80 

2-80 SETTING THE DOWN POSITION OFFSET 
 

 

NOTE:  If the layer in step 3 is also the milling layer, a second milling layer with as 
tool the miller will have to be created (see section Error! Reference source not 
found.). 

 
NOTE:  If bridges will be used, use them in this last cleaning pass only. 
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1.10 Camera – media calibrations 
 
1.10.1 Basic calibration of the camera and registration mark recognition 
 
This section is for SummaFlex Pro only. SummaFlex Pro has no camera support. 
This calibration makes sure the flatbed cutter cuts on the exact place it should cut. The 
calibration consists out of two parts. It is recommended to do both calibrations if there is an 
offset problem.  
The first part of the calibration calibrates the resolution of the camera (#pixels/mm). The 
second calibration calibrates the physical distance between the center of the camera and the 
knife.  
A cutting tool will have to be mounted on the flatbed cutter and it should be calibrated to cut 
normal vinyl (the second calibration will have to be done on black vinyl with white backing). 
The tool should be mounted in the most left module, since SummaFlex Pro uses the most left 
module for the second part of the calibration. 
 

 
1. Make sure the flatbed cutter is connected and switched on and the SummaFlex Pro 

security key is connected. Keep a piece of black vinyl with white backing ready and mount 
the  drag head module and drag knife. Start SummaFlex Pro. 

2. Go to File -> Open and open 0701080001.job. 

 

FIG 2-81 
2-81 OPEN JOB 

 

 

NOTE: It is recommended to do the first calibration with the actual printer that will 
be used for the print and cut jobs. However, it can also be done with a desktop 
printer (this will make the recognition of the registration marks less accurate). 
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3. Export the file to an EPS or PDF file so it can be used to print out on the printer that will 
be used for the print and cut job. If this printer is not available, this job can also be 
printed out on a normal desktop printer. Go to File -> Print. Make sure the file is printed 
out on scale 1:1 (click on the button).  

 

FIG 2-82 
2-82 PRINTING THE JOB FOR CAMERA CALIBRATION 

 
4. Assign a cutting tool to the cut line. For this, click on ‘Default’ under ‘Cutpath’ and choose 

the most left installed tool. Click on Macros if the view at the right side of the SummaFlex 
Pro window is not the same as in the picture below. 

 

FIG 2-83 
2-83 SETTING TOOL 
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5. Load the printout on the flatbed cutter. Go to File -> Output… Or use the Output to device 
macro (click the blue arrow). A window will open. Click the read material button to check 
if the communication with the flatbed cutter functions. 

 

FIG 2-84 
2-84 OUTPUT WINDOW 

 
6. Click the preview button. Another window will open. Use the arrow keys to move the 

camera until it is situated over a registration mark (black circle is visible). Move the cursor 
in the camera view area, right click and then go to Default settings -> Mark recognition. 
The window will expand at the bottom to show the calibration options. 

 

FIG 2-85 
2-85 REGISTRATION MARK RECOGNITION 
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7. Click ‘Move to mark’  and then click ‘Measure’. Click ‘Move to mark’ again to check if the 
orange and the green circle fit on top of each other. If the green circle hides the orange 
circle, then the measurement has succeeded. Click ‘Save’ to save the result. 

 

FIG 2-86 
2-86 MEASURING REGISTRATION MARK 

 
Explanation of the colours in the camera window: 
 

1. A red circle means the program has recognized the shape as a registration mark, 
but it is not yet in the recognition area for accurate recognizing. 

2. A green circle means the program has recognized the shape as a registration mark 
and it is in the recognition area for accurate recognizing. 

3. The orange circle is where the program thinks the registration mark is situated and 
how large it is. 

4. The orange square is the accurate recognition area. The center of the registration 
mark needs to be in there for accurate recognition. 

 

 

 

 

ATTENTION: If more than one camera is attached to the computer, it is possible the 
program chooses the wrong camera. This can be changed in this window. Just click 
the dropdown box at the top of the window and choose the videology USB camera.  

 

ATTENTION: It is recommended to disable all other cameras connected to the 
computer, if possible. Otherwise these cameras can interfere with SummaFlex Pro. 
Extra cameras generate extra data stream on the USB port and may result in data 
loss.  
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8. Click the Axis Control icon and deactivate the vacuum. Remove the printed sample and 
replace by black vinyl with white backing (make sure there is a big contrast between vinyl 
colour and backing colour). Switch the vacuum on again and go to SummaFlex Pro. Right 
click on the camera area and go to Set camera offset. 

 

FIG 2-87 
2-87 SET CAMERA OFFSET 

 
9. Move the head to an area where there is nothing cut in the vinyl. Click Cut Mark. Wait for 

the machine to cut a circle with the mark size and a rectangle around it. Peel the 
rectangle around the circle. Use the arrow keys to move the camera until it is situated 
over a mark (black circle is visible). Click Measure. Click Save to save the measured offset. 

 

FIG 2-88 
2-88 CAMERA OFFSET MEASURED 

 

 

 

 
NOTE: If the calibration has to be redone, choose another position away from the 
already used positions.  

 

NOTE: The basic setting-up and calibration for SummaFlex Pro is now done and can 
be used. It is recommended to further refine the setup of the program, so it fits in 
the normal used workflow. Once this is done a user profile can be made, so as much 
unnecessary options and settings as possible are hidden.  
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1.10.2 Configuring the camera profile 
 
Special combinations of registration mark colour/ media colour or media texture might need 
special camera profiles. Such profiles can be made by the user. Although it is recommended 
that those profiles are made by the dealer or Summa. There are some profiles already pre-
installed when SummaFlex Pro is installed. 
They can be found in the directory C:\Program Files\Summa\SummaFlex Pro\cutter\img. 
The procedure to install extra profiles or to change the profile in SummaFlex Pro is described 
below. 
 

1. If the dealer sends new profiles, copy them in the profile directory. 

 
FIG 2-89 

2-89 CAMERA PROFILE DIRECTORY 
 

2. Start the job in SummaFlex Pro in the output window. Click Mark type and change it to 
User defined. 

 
FIG 2-90 

2-90 CHANGE THE REGISTRATION MARK SETTINGS 
 
3. Click the preview button. Another window will open.  Move the cursor in the camera view 

area, right click and then go to Default settings -> Mark recognition.  

 

FIG 2-91 
2-91 MARK RECOGNITION 

4. In the dropdown box next to ‘Profile’, choose the correct profile.  
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ATTENTION: Only use a different camera profile from the standard one if the reading 
of the registration marks gives problems. If the camera profile is not necessary 
anymore, then it suffices to set the mark type to circle again.  It is not necessary to 
set the camera profile to its default value again (0.ipp). 

 
NOTE:  It is advised to define special output profiles for different configured camera 
profiles, see section 2.8.4. 
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1.11 Tandem mode (not for F1612) 
 

With the Tandem Mode, the active working area on the flatbed can be divided into front and 
back processing areas, which enables the user to load and unload material on one end of the 
table while cutting material on the other end of the table. This will avoid idle periods during 
the processing of material, which will add significant value to the overall workflow. 

 
FIG 2-92 

2-92 TANDEM MODE 
 

1.11.1 Setting up the tandem mode 
 

In order to facilitate loading the jobs on the table, it is recommended to mark the place 
where the media has to be loaded. It is not necessary to do this each time the tandem mode 
is used. Only when the lines are faded, is it necessary to redraw them.  
 

1. Go to the media menu in Axis Control.  

2. Go to ‘Set origin’. Click the pointer button. Move the carriage as far as possible to the 
front and to the right. Mark this point on the conveyor. 

3. Move the carriage 15 to 20 cm to the left (make sure the carriage does not move to the 
back. Mark this point also. 

4. Move the carriage back as far as possible to the right and then move the carriage 15 to 
20 cm to the rear (make sure the carriage does not move to the left). Mark this third point 
also.  

5. Now, move the carriage out of the way and draw a line from the origin to the two other 
points. Afterwards, move the carriage back to the origin and click OK. 

 
FIG 2-93 

2-93 ORIGIN MARKED 
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6. Go to ‘Set media size’. Click the pointer button. Move the carriage as far as possible to the 
back and to the left. Mark this point on the conveyor (“full size mark”). 

7. Move the carriage 15 to 20 cm to the right (make sure the carriage does not move to the 
front). Mark this point also. 

8. Move the carriage back as far as possible to the left and then move the carriage 15 to 20 
cm to the front (make sure the carriage does not move to the right). Mark this third point 
also. 

9. Now, move the carriage out of the way and draw a line from “full size mark” to the two 
other points. 

10. Move the carriage back to “full size” and click OK. 

11. This marks the opposite origin for the tandem mode. 

 
FIG 2-94 

2-94 ORIGIN AT THE OPPOSITE SIDE MARKED 
 
Now that the conveyor is marked, the front and rear origin point and the conveyor are in the 
correct position to start the tandem mode. If the position of the conveyor and origin points 
needs to be set correctly after the conveyor has moved because of another job, then do 
following to set the positions correctly again: 
 
12. Check if the front origin point is visible at the right side. If this is the case, go to the 

media menu in Axis Control, go to ‘Set origin’ and click the pointer button. 

13. Now, set the pointer above the corner of the origin mark and click the feed button.  

14. If the origin mark is not possible, then click ‘feed’ and feed the conveyor for 3000 mm. 
Execute a check once more. 
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1.11.2 Using the tandem mode in SummaFlex Pro 
 
The tandem mode is used to cut multiple copies over different sheets. Axis Control is used to 
let SummaFlex Pro know if the media is loaded or not. If SummaFlex Pro does not get a 
signal that the media is loaded, then it will send a message to the user through Axis Control, 
informing him where to load the media. Whilst the table is cutting on one side, follow 
following steps: 
 
1. Import the job in SummaFlex Pro. Set the tool parameters correctly and launch the job. 

Select the tandem mode in the output window.  

 
FIG 2-95 

2-95 SELECT TANDEM MODE IN OUTPUT WINDOW 
 

2. If it is a print and cut job, fill out the number of copies in the list of the OPOS parameters 
“total number of copies” (left side of the figure).  

3. If it is a cut only job, then fill out the number of copies next to “number of jobs” (right 
side of figure). 

 

FIG 2-96 
2-96 NUMBER OF COPIES TANDEM MODE 
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4. Click on the output button. Axis Control will ask to put the media at the front side of the 
table.  If Axis Control is not running in the foreground, a message will appear in the lower 
right corner of the screen. Click it. If Axis Control is running on the foreground, the 
message appears in the event area of Axis Control. Click OK if the media is loaded. 

  
FIG 2-97 

2-97 MEDIA LOAD MESSAGE START TANDEM MODE 
 
5. If it is a print and cut job, the camera will go to the origin and wait for the user to set the 

camera above the first mark. If there are multiple copies in one job, then either fill out the 
distance between the copies in advance, or set the production mode on manual - > 
production, so SummaFlex Pro can learn the distance between the copies.  After reading 
the marks, a button “Release Area” will appear in the Axis Control windows. While the first 
job is cut on the table, the rear beam between the two safety poles is disabled. The user 
can pass through and load the media on the rear area of the table. After loading the 
media, click the button ‘Release Area. 

 
FIG 2-98 

2-98 AREA RELEASE BUTTON TANDEM MODE 
 

6. This procedure can be repeated until all copies are cut. If the user loads the media while a 
copy is cut at the other end of the table and clicks on the Area release button, the cutting 
process will not be interrupted until all copies are cut. If the media is not ready, Axis 
Control displays a message, similar to the first message, which Axis Control gives at the 
start of the procedure, and waits. 

 

 
 
 

 

NOTE:  With a print and cut job, SummaFlex Pro will come to the foreground each 
time the marks are read. Click the Axis Control icon in the taskbar after the marks 
have been read in order to get Axis Control on the foreground again.  

 

NOTE:  Make sure the jobs for the tandem mode are shorter than 1300 mm. If the 
job is larger, then it will be clipped at 1339 mm when the media is loaded at the 
front and at 1339 mm when the media is loaded at the rear.  



 User’s Manual 

 

Operation  1-84 

1.12 Continuous workflow fixed feed 
 
The continuous workflow method is mostly used on the F1612 in combination with a table at 
the back and in front of the machine. If the job consists out of multiple copies on multiple 
sheets, the sheets can then be loaded at the back, while the machine is cutting a job.  
 
To this purpose, a table is placed in front of and behind the machine. 
In order to enhance easy loading, draw the origin lines on the mat (2) (see section Error! 
Reference source not found.) and apply rulers on the table, which is placed at the back (1).  

 
FIG 2-99 

2-99 PREPARE F1612 FOR CONTINUOUS WORKFLOW FIXED FEED 
 

Follow the procedure below for the continuous fixed feed workflow for sheets.  
 
1. First set the media size. The width is equal to the width of the job. The length is set at its 

maximum (1200 mm). Load the first copy at the back of the table. Multiple copies may be 
loaded next to one another. Make sure to stay within the drawn origin lines.  

 
FIG 2-100 

2-100 LOAD FIRST COPY 
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2. The recommended length of the sheets is between 560 mm and 1150 mm. The minimum 

size is 300 mm (otherwise the sheet cannot be loaded). Subtract 550 mm from the sheet 
length. Remember that value. If the table behind the F1612 is put as close as possible to 
the F1612 and the rulers start at 0 mm from the side of the table, the sheet needs to be 
loaded right up to the mark with the obtained value. For instance, in the figure below, the 
sheet size is 700, which means the sheet is loaded at the 150 mm mark. 

            
FIG 2-101 

2-101 LOAD FIRST COPY 
 

3. Go to the Axis Control media menu and feed a 1200 mm. The sheet will now be 
transported to the beginning of the table.  

 
FIG 2-102 

2-102 LOAD FIRST COPY 
 

4. A second job can be put on the back of the F1612 and can be aligned the same way as the 
first one; with the ruler on the table behind the machine. Go to SummaFlex Pro and load 
the job. Check if the orientation on screen is correct and if the correct tools (with the 
correct tools settings) are selected in SummaFlex Pro. Click ‘output to device’. Then set 
the mode to ‘Output assignment Fixed Feed’. 
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FIG 2-103 

2-103 START OUTPUT 
 

5. Choose the number of copies if more copies are placed next to one another. Then fill out 
that value next to the number of copies in the Y direction. 

 
6. Start the job by clicking on the Output button. Navigate the camera above the first mark 

and click OK. The first job(s) will be processed. 

7. After the first job is done, the F1612 will move the media forward and put it on the table 
in front of the F1612, while the second row is loaded. The F1612 will continue to process 
this job without user interference. While this job is cut out, the operator can put the next 
job on the table, positioned at the back of the F1612 the same way in which the other 
sheets were loaded. 

 
 

 

 
NOTE:   It is not possible to put multiple copies in the X direction (because of a 
feeding issue), so the copies have to be processed row per row. 
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1.13 Barcode workflow 
 

The camera of the F Series can also read barcodes. Certain RIP’s have the ability to print a 
barcode together with the OPOS marks. This barcode can then be used to identify the job and 
retrieve the needed cut data automatically from the computer.  
The program Axis Control reads the barcode and supplies the info to the program 
SummaFlex Pro in order to open the file with the cut data and send the data to the cutter. 
After finishing the job, the program SummaFlex Pro returns control to the program Axis 
Control, so it can verify whether another job with a barcode is printed.  If this is the case the 
whole procedure repeats itself.  
Check the manual for the F series on how to calibrate Axis Control in order to read the 
barcode correctly.  Make sure to do this before setting up SummaFlex Pro for a barcode 
workflow. 
  
The installation manual describes how to install the license for the barcode flow option in 
section 2.  
 
1.13.1  Parameter settings in SummaFlex Pro for barcode workflow 
 
There are a couple of extra settings that need to be checked/changed. Start SummaFlex Pro.  
 
1. Click Settings. Go to Standard settings Miscellaneous. Click it.  

 

2. Make sure the box in front of “Don’t ask for save on exit” is checked. Click the OK button. 

 

3. Click Settings. Go to Standard settings Filter. Click it.  
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4. Make sure the boxes in front of “Separate layers by name”, is checked.  

 

5. Click the OptiSCOUT button.  

6. Make sure the box in front of “Create a new job”, “… and close active job” and “Get jog 
marks from layer” is checked. Make sure the box before “After Drag’n Drop rotate objects 
using an angle of” is not checked. 

 

7. Click the OK button. In the OptiSCOUT import window. Then click the OK button in the 
Import/Export window. 
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1.13.2 Setup of a general barcode workflow profile  
 
A standard profile for the barcode workflow is installed when the program SummaFlex Pro is 
installed. A couple of settings need to be adjusted/checked. Follow the below procedure to 
set up a correct profile. 
 
1. Click on the production tab, then click on the dropdown box next to ‘Standard’ in the 

upper right corner and select Summa Postnet. 

 

2. Click the gear icon on the upper right corner next to Summa Postnet.  

 

3. Select Edit copy profile. 
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4. First change the profile name which will reflect the types of jobs. Then in the profile 
window, click the barcode tab. 

 

5. Click the more icon ( ) next to Summa Postnet PDF.  

 



 User’s Manual 

 

Operation  1-91 

 

6. Click the dropdown box after Summa Postnet PDF and click Summa Postnet OXF. 

 

 

7. Check if the string “ .*{0}.oxf ” is filled out next to the Extended comparison field. If not, 
fill it out. Click the save button. 
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8. Click on the dropdownbox next to the empty field and select Summa Postnet OXF. 

 

9. Click the more icon ( ) next to Directory for cut files. Then locate the directory where 
the barcode files from the RIPS are stored and click the OK button. 

 

10. Click the save button. 
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11. Put the media on the table with the registration marks printed on it. Set the origin of the 
media above a registration mark. Use the camera as described in the manual for the F 
series. 

 

 

12. Click the production tab.  Click the gear icon in the upper right corner and select “Camera 
settings”. Click the “Adjust” button so the size of the mark is calibrated (the X and Y value 
will change to a value between 125 and 140).Then click “Move to mark”.  The camera now 
moves above the mark. Click the “Save” button. 

      

 

13. Check the tool setting. Once the barcode workflow is set in motion, there is no possibility 
to change the tool or tool parameters. So these settings have to be checked before a 
barcode job is started. To do this, import a file from the barcode directory. Check the tool 
settings. Adapt if necessary (see section 1.13.3.1 for extra options). 

14. Also check the sorting order for the reading of the registry marks. To do this, import a file 
from the barcode directory. Then click on the ‘Sort with simulation’ macro. Then click the’ 
View default settings’ button (bottom right). In the new window check the box before 
‘Sorting settings for registration marks’ and fill the rest in as in the picture below. Then 
click Apply and OK.  
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15. Now the barcode profile is set up and ready for a first test. It is recommended to do a 
separate test first in order to check if Axis Control can read the barcode correctly. This 
test is described in the F series manual in the section about Axis Control. Put a printed 
barcode on the table, do the test and adjust the parameters, if needed, as described in the 
;qnuql for the F series< 

16. First make sure Axis Control is running (it should always be running while the table is 
switched on). To run the barcode workflow, choose the correct barcode workflow profile 
first. Click the green triangle. 

 

17. Axis Control will appear in the foreground with a window showing what the camera is 
registering. Use the arrows in that window to position the camera above a piece of the 
barcode (such as in the figure below) then press “Apply”. 

 

18. The barcode will now be sensed. If the barcode is recognized, it will send the result to 
SummaFlex Pro and go to the background. SummaFlex Pro will open the file with the cut 
data (if it is found in the cut file folder). The marks will be sensed and the vectors will be 
cut automatically. The beginning of the next barcode will be searched for.  Once it is 
found, the whole procedure will repeat itself. 
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1.13.3 Setup additional barcode workflow profiles 
 
The previous section describes the general barcode workflow. In most cases this will be 
sufficient for working roll to roll with standard tool settings. There are, however, some extra 
settings usable in the barcode workflow for specific jobs. 
 
The parameters, visible in the general device setting of the profile, can differ a bit depending 
on the installed SummaFlex PRO version. However, if certain parameters are not visible, they 
can easily be added. 
 
The figure below shows the recommended parameters, that need to be set visible. However, 
if they are not used, it is not necessary to make them visible.  
 

 
 
If the parameters are not visible then do following to add them: 
 
Click the add parameter button.  
 

 
 
Then select the parameter that needs to be in the list by clicking it. The parameter is selected 
when the background of the parameter becomes light grey. Click ‘add’. 
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Do this for all the parameters that need to be in the list.  
 
1.13.3.1 Setting up barcode workflow with specific tool settings 
 
Specific palettes can be prepared and then used in a separate profile, so it is not necessary 
to change the palette before each barcode job. Just choose the correct barcode workflow 
profile that automatically opens the correct palette. 
 
1. To prepare a palette, open SummaFlex Pro and click the Layer tab (1). Right click in the 

list of layers. Change a specific setting (3) in the layer window, or assign appropriate tools 
(4), or choose a preset material (5) (see section 2.3- setting up layers).  Click OK. 

 
FIG 2-104 

2-104 SETTING UP LAYER FOR BARCODE WORKFLOW 
 
2. Save the altered palette under a recognizable name to the material directory of the 

barcode workflow. This directory is “C:\Program Files (x86)\Summa\SummaFlex 
Pro\Materials\SUMMA F-SERIES CAM”  
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3. To make an additional profile with the tool settings as set in the palette that was just 
made do following: 

4. Make sure the normal profile is selected. Click the gear icon and select edit copy. 

 
 

5. In the newly opened window, change the profile name to an easy recognizable name. 
Select the palette with the correct tool settings next to Material. 

 

6. Click the save button  
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Setting up barcode workflow for sheet mode 
 
1. Make sure the normal profile is selected. Click the gear icon and select edit copy. 

 
 

2. In the newly opened window, change the profile name to an easy recognizable name. Set 
the Material parameter to sheet, the Feed after last segment to off and Option group park 
position to End. Other parameters can be changed to the user’s convenience, but the 
previously mentioned parameters need to be set as such. 

 
 

3. Click the save button. 
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